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Welcome to CB Predictor

Welcome to CB Predictor Version 1.2, a new addition to the 
Crystal Ball suite of decision intelligence products!

Forecasting is an important part of many business decisions. 
Every organization needs to set goals, try to predict future 
events, and then take actions that will hopefully fulfill the goals. 
As the timeliness of market actions becomes more important, 
the need for accurate planning and forecasting throughout an 
organization is essential to get ahead. The difference between 
good and bad forecasting can affect the success of an entire 
organization.

CB Predictor is an easy-to-use, graphically oriented forecasting 
add-in for Microsoft Excel spreadsheet users. If you have 
historical data in your spreadsheet, CB Predictor will analyze 
your data for trends and seasonal variations. It will then predict 
future values based on this information. You will be able to 
answer questions such as, �What are the likely figures for next 
quarter�s sales?� or, �How much material do we need to have on 
hand?� With CB Predictor, you will no longer have to pull these 
numbers out of thin air. Instead, you can rely on robust, 
statistically proven techniques to accurately create these 
predictions.

To get started, all you need is a spreadsheet containing 
historical data. From there, this manual guides you step by step, 
explaining forecasting terms and results.

Who this program is for
CB Predictor is for the planner and forecaster in every 
organization�from the sales manager predicting next quarter's 
sales, to the marketing specialist forecasting the results of an 
advertising campaign, to the financial officer projecting likely 
revenue figures and cash flows. CB Predictor has been 
developed with a wide range of forecasting applications in 
mind.

You don't need highly advanced statistical or computer 
knowledge to use CB Predictor to its full potential. All you need 
is a basic working knowledge of your computer and Microsoft 
Excel, plus a solid understanding of your own business 
fundamentals. 
CB Predictor User Manual 7



Introduction Welcome to CB PredictorI
What you will need
To run CB Predictor, you will need the following:

� Microsoft Excel 95 (or later) 

� Windows 95, Windows 98, Windows NT 4.0, or Windows 2000

� Personal computer with Pentium microprocessor and at least 
16 MB RAM

� Hard disk drive with at least 3 MB free

� 2X CD-ROM drive or faster

� VGA or SVGA graphics card or compatible video graphics 
adapter and monitor

Recommended system requirements

� Pentium II, 200 MHz or faster

� 24 MB RAM or more

How this manual is organized
The manual includes the following: 

� Chapter 1 - �Getting Started with CB Predictor�

This chapter contains two tutorials designed to give you a 
quick overview of CB Predictor�s features and to show you 
how to use it. Read this chapter if you need a basic 
understanding of CB Predictor.

� Chapter 2 - �Understanding the Terminology�

This chapter contains a thorough description of forecasting 
and statistical terms. Read this chapter carefully if your 
statistics background is limited or if you need a review. 

� Chapter 3 - �Forecasting with CB Predictor�

This chapter contains the step-by-step procedures for using 
all of the features in CB Predictor.

� Chapter 4 - �Examples�

This chapter contains example data from various fields.
8  CB Predictor User Manual
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� Chapter 5 - �Using CB Predictor with Crystal Ball�

This chapter contains descriptions of how to use CB 
Predictor with Crystal Ball. It also has some examples that are 
Crystal Ball-specific.

� Appendices

� A - �Time-series Forecasting Method Formulas�

The formulas used for the time-series forecasting 
methods.

� B - �Error Measure and Statistic Formulas�

The formulas used for time-series error measures and 
other statistics.

� C - �Techniques for Finding Regression Coefficients�

How the program determines the coefficients of 
regression equations.

� D - �Regression Statistic Formulas�

The formulas used to calculate the statistics to gauge the 
quality of the regression and the coefficients.

� E - �Error Recovery�

A list of the most important CB Predictor error messages 
with directions for error recovery. 

� Bibliography

A list of related publications, including statistics textbooks.

� Glossary

A compilation of terms specific to CB Predictor as well as 
statistical terms used in this manual.

� Index

An alphabetical list of subjects and corresponding page 
numbers.
CB Predictor User Manual 9



Introduction What�s new in this releaseI
What�s new in this release
There are several new features in CB Predictor, Version 1.2.

New forecasting techniques
You can now select to use different time-series forecasting 
techniques:

� Simple lead (see page 51)

� Weighted lead (page 52)

� Holdout (page 52)

New regression methods
You can now select different multiple linear regression methods 
in addition to standard. These are:

� Forward stepwise (see page 55)

� Iterative stepwise (see page 56)

There is also a new options dialog to support the stepwise 
methods that lets you set stopping criteria of R-squared and F 
statistic, as well as set the probabilities that control when 
independent variables are added or removed from the 
regression equation.

Plus, for any regression, you can specify to lag or not to forecast 
selected independent variables.

Additional statistics
CB Predictor now calculates and displays:

� The autocorrelation for all historical data in the View Data 
dialog

� The associated Ljung-Box statistic for these autocorrelations

� Residuals in the Results table
10  CB Predictor User Manual



1

Additional resources

Decisioneering, Inc. offers these additional resources to 
increase the effectiveness with which you can use our product.

Technical support
Decisioneering, Inc. offers free technical support for 30 days. If 
you have a technical support question or would like to comment 
on CB Predictor, there are a number of ways to reach technical 
support described in the README file in your CB Predictor 
installation folder.

Consulting referral service
Decisioneering, Inc. provides referrals to individuals and 
companies alike. The primary focus of this service is to provide 
a clearinghouse for consultants in specific industries who can 
provide specialized services to the forecasting community.

If you wish to learn more about this referral service, call 800-
289-2550 Monday through Friday, between 9:00 A.M. and 5:00 
P.M. Mountain Time or see our website at 
www.decisioneering.com.

Conventions used in this manual
This manual uses the following conventions:

Text separated by > symbols means you select menu options in 
the sequence shown, starting from the left. The following 
example means that you select the Exit option from the File 
menu:

1. Select File > Exit.

Steps with attached icons mean you can click on the icon instead 
of manually selecting the menu options in the text. For example:

2. Select Tools > CB Predictor. 
CB Predictor User Manual 11
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Notes provide additional information, expanding on the text. 
There are five categories of notes:

CB Predictor Note:  Notes that provide additional directions or 
information about using CB Predictor.

Crystal Ball Note:  Notes that provide additional directions or 
information about using Crystal Ball.

Statistical Note:  Notes that provide additional information about 
statistics.

Excel Note:  Notes that provide additional information about using the 
program with Microsoft Excel.

Windows Note:  Notes that provide additional information about using 
the program on a Windows system.

Screen capture notes
Almost all of the screen captures in this manual were taken in 
Excel 97 for Windows NT using the stand-alone version of CB 
Predictor.

Also, due to round-off differences between various system 
configurations, you may also notice slightly different calculated 
results than those shown in the examples.

Example file names
Example names are listed in full wherever given. You can find 
the example files in their Examples folder. For example, to find 
the �Toledo Gas� example, select �Toledo Gas.xls�. 
12  CB Predictor User Manual



Chapter 1

Getting Started 
with CB Predictor



In this chapter
� What is time-series forecasting

� Shampoo Sales tutorial

� How CB Predictor works

� Toledo Gas tutorial

� How regression works

This chapter has two tutorials, a short one 
and a longer one, that provide an overview 
of CB Predictor�s features. The first 
tutorial, Shampoo Sales, is ready to run, 
using most of the defaults. The results 
forecast the next quarter�s worth of 
shampoo sales.

The second tutorial, Toledo Gas, uses 
regression, previews the results, and sets 
some additional options. The results 
predict the next year�s worth of residential 
gas usage for Toledo.

Now spend some time learning how CB 
Predictor can help you forecast the future.



1

What is time-series forecasting?

�Prediction is very difficult, especially if it�s about the future.�
- Niels Bohr
 Nobel laureate in Physics

How often are you asked to estimate future sales? Staffing 
requirements? Budget items? Do you have to predict numbers 
for the next year using historical numbers that are higher in the 
summer than the winter? Or with numbers that rise and fall with 
the Dow Jones industrial average? You need CB Predictor!

If you have historical time-series data, you can use CB Predictor 
to examine your historical data and predict what the future 
trends will be. You no longer have to assume that sales will be 
same as last quarter, or that you will spend 10% more next year 
on expenses than this year. CB Predictor will apply a battery of 
sophisticated statistical methods to your data series to find a 
result that even an experienced forecast expert would be 
confident of.

To predict future values, CB Predictor uses two types of 
forecasting: time-series forecasting and multiple linear 
regression. Time-series forecasting breaks down your historical 
data into four components: level, trend, seasonality, and error. 
CB Predictor analyzes each of these components and then 
projects them into the future to predict likely results. 

When you know that outside influences have an effect on the 
variable you want to forecast, you need regression. Regression 
takes historical data from the influencing variables and 
determines the mathematical relationship between these 
variables and your target variable. It then uses time-series 
forecasting methods to forecast the influencing variables, and 
combines the results mathematically to forecast your target 
variable.

After finding the best forecast for your data, CB Predictor will 
paste the forecasted values into your spreadsheet. You can also 
request detailed output that includes statistics, charts, reports, 
and PivotTables. CB Predictor can also create your forecasted 
values as Crystal Ball1 assumptions, ready for a �what if � 
simulation.

Glossary Term:
time series�
A set of values that are 
ordered in equally spaced 
intervals of time.

Glossary Term:
level�
A starting point for the 
forecast.

Glossary Term:
trend�
A long-term increase or 
decrease in time-series data.

Glossary Term:  
seasonality�
The change that seasonal 
factors cause in a data 
series. For example, if sales 
increase during the 
Christmas season and during 
the summer, the data is 
seasonal with a one-year 
period.

Glossary Term:
error�
The difference between the 
actual data values and the 
forecasted data values.
CB Predictor User Manual 15



Chapter 1 Getting Started with CB Predictor
Shampoo Sales tutorial
The easiest way to understand what CB Predictor does is to 
apply it to a simple example. In this example, you are Carl, sales 
manager for Tropical Cosmetics Co. The company�s latest 
product, shampoo with tropical ingredients, has been in the 
marketplace for almost a year now. The vice president of 
marketing wants you to forecast the rest of the year�s sales of 
shampoo and decide whether to recommend investing in 
advertising or enhancements for this product.

You have the weekly sales numbers for the last nine months. 

To begin the tutorial:

1. Start CB Predictor from Windows by selecting either:

� For stand-alone CB Predictor, Start > Programs > 
CB Predictor > CB Predictor.

Excel starts and the CB Predictor toolbar appears.

� For CB Predictor as part of Crystal Ball 2000, 
Professional Edition, Start > Programs > Crystal Ball > 
Crystal Ball.

Excel starts and the Crystal Ball menus and toolbar 
appear.

2. Open the Shampoo Sales spreadsheet from the Examples 
folder. You can find this folder by selecting either:

� For stand-alone CB Predictor, Start > Programs > 
CB Predictor > Examples.

� For CB Predictor as part of Crystal Ball 2000, 
Professional Edition, Start > Programs > Crystal Ball > 
Examples.

An Explorer window opens directly to the Examples folder, 
and when you double-click on the icon, the Shampoo Sales 
spreadsheet appears in Excel.

1. For stand-alone CB Predictor users, Crystal Ball® is Decisioneer-
ing�s risk analysis add-in for Excel that can be purchased sepa-
rately.
16 CB Predictor User Manual 
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Figure 1.1  Shampoo Sales spreadsheet

In this spreadsheet, there is one column of Tropical shampoo 
sales data next to a column with dates from January 1, 1999 until 
September 24, 1999. You need to forecast sales through the end 
of the year, December 31, 1999.

3. Select cell B4.

Selecting any one cell in your data range, headers, or date 
range initiates CB Predictor�s �Intelligent Input� to select all 
the filled, adjacent cells.

4. Either:

� For stand-alone CB Predictor, select Tools > CB 
Predictor.

� For CB Predictor as part of Crystal Ball, select CBTools > 
CB Predictor.

The CB Predictor wizard opens to the Input Data tab.
CB Predictor User Manual 17
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Figure 1.2  Input Data tab

When you select any one cell in the data range before you start 
the wizard, CB Predictor�s Intelligent Input guesses:

� Your data series (In this case, A3:B42)

� Whether your data is in columns or rows

� Whether you have headers at the beginning of your data

� Whether your first column or row contains dates or time 
periods
18 CB Predictor User Manual 
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5. Click on Next.

The Data Attributes tab appears.

Figure 1.3  Data Attributes tab

6. Under Step 4:

a. Select �weeks� from the Data Is In list.

b. Set the data to have no seasonality.

You have less than the two seasons of data, so cannot use 
seasonality.

7. Under Step 5, make sure that Use Multiple Linear 
Regression option is not checked.

You did not choose regression because you have only one 
series of data, so there is no dependencies between series 
requiring regression.
CB Predictor User Manual 19
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8. Click on Next.

The Method Gallery tab appears.

Figure 1.4  Method Gallery tab

9. Click on Select All.

This selects all the time-series forecasting methods, but CB 
Predictor doesn�t use the seasonal methods, since you 
indicated that your data was not seasonal.

CB Predictor will forecast your values using each of the 
selected methods and rank them according to how well they 
fit the historical data. CB Predictor uses the seasonal 
methods as well as the nonseasonal methods if you indicate 
on the Data Attributes tab that your data series have 
seasonality. 
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10. Click on Next.

The Results tab appears. The only output selected by default 
is Paste Forecast, which adds the forecasted values to the end 
of your historical data.

Figure 1.5  Results tab

11. Under Step 7, forecast the weekly sales for the rest of the 
year by entering 13 in the field.
CB Predictor User Manual 21
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12. Click on Preview.

The Preview Forecast dialog appears, showing a graph with 
the historical data, the fitted data, the forecast values, and the 
confidence interval.

Figure 1.6  Preview Forecast dialog

13. In the Preview Forecast dialog, click on the Method field.

The field lists all the methods CB Predictor tried, in order 
from the best-fitting method (designated by the word �Best�) 
to the worst-fitting method. CB Predictor calculates the 
forecasted values from the method that best fits the historical 
data, in this case, Double Moving Average. 

The forecasted values appear as a blue line extending to the 
right of the historical data (green) and the fitted values (also 
in blue). Above and below the forecasted values is the 
confidence interval (in red), showing the 5th and 95th 
percentiles of the forecasted values.
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14. Click on Run.

The program pastes the forecasted values to the end of the 
historical data (in bold), extending the date series as well. 
The forecasted values were forecasted using the best method, 
as shown in the Preview dialog. 

Figure 1.7  Pasted shampoo sales values

For stand-alone CB Predictor, if you configured Crystal Ball to 
start automatically with Excel, the program also defines the 
output values as assumptions. See Chapter 5, �Using CB 
Predictor with Crystal Ball� for more information on using CB 
Predictor with Crystal Ball.

Forecasted Values

Historical Data
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After running the forecast, you complete your memo to upper 
management:

How CB Predictor works
Most historical or time-based data contains some kind of 
underlying trend or seasonal pattern. However, most historical 
data also contains random fluctuations or �noise� that makes 
detecting these trends and patterns difficult without the aid of a 
computer. CB Predictor uses sophisticated time-series methods 
to analyze the underlying structure of your data. It then projects 
out the trends and patterns to predict future values.
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When you run CB Predictor, it tries each time-series method on 
your data and calculates a mathematical measure of goodness-
of-fit. CB Predictor selects the method with the best goodness-
of-fit as the method that will yield the most accurate forecast. CB 
Predictor performs this selection automatically for you, but you 
can also select individual methods manually, or override the 
method CB Predictor recommends with a different one.

The final forecast shows the most likely continuation for your 
data. Keep in mind that all these methods assume that some 
aspects of the historical trend or pattern will continue into the 
future. However, the farther out you forecast, the higher the 
likelihood that events will diverge from past behavior, and the 
less confident you can be of the results. To help you gauge the 
reliability of your forecast, CB Predictor provides a confidence 
interval indicating the degree of uncertainty around your 
forecast.

The final step of forecasting involves interpreting the results 
and integrating them into your decision-making process. CB 
Predictor provides comprehensive output to assist you in this 
process. You can request detailed reports, customizable Excel 
charts and graphs, and summary PivotTables. CB Predictor can 
also automatically create Crystal Ball assumptions for each 
forecasted value, letting you integrate risk analysis into the 
process.

Toledo Gas tutorial
Suppose you work for Toledo Gas Company in the Residential 
Division. The Public Utilities Commission requires you to 
predict the gas usage for the coming year to make sure that the 
company can meet the demand.
CB Predictor User Manual 25
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To start the tutorial:

1. In Excel with CB Predictor loaded, open the Toledo Gas 
spreadsheet from the Examples folder. To find this folder 
select either:

� For stand-alone CB Predictor, Start > Programs > 
CB Predictor > Examples.

� For CB Predictor as part of Crystal Ball 2000, 
Professional Edition, Start > Programs > Crystal Ball > 
Examples.

An Explorer window opens directly to the Examples folder, 
and when you double-click on the icon, the Toledo Gas 
spreadsheet appears in Excel.

Figure 1.8  Toledo Gas spreadsheet

2. Select cell C5.

3. Select either:

� For stand-alone CB Predictor, Tools > CB Predictor.

� For CB Predictor as part of Crystal Ball, CBTools > 
CB Predictor

The Input Data tab appears. CB Predictor�s Intelligent Input 
feature selects all the data from cell B4 to cell F100.
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4. Click on Next.

The Data Attributes tab appears.

Figure 1.9  Data Attributes tab

Using regression
Through research, you know that your residential gas usage is 
primarily affected by three variables: new home starts, the 
temperature, and the price of natural gas. However, you aren�t 
sure how much effect each has on gas usage.

Because you have independent variables affecting a dependent 
variable (the variable that you are interested in), this forecast 
requires regression. For regression, CB Predictor uses a 
technique called HyperCasting�, which in one easy step:

a. Creates an equation that defines the mathematical 
relationship between the independent variables and 
your dependent variable.

b. Forecasts each independent variable using time-series 
forecasting methods.

Glossary Term:
regression�
A process that models a 
dependent variable as a 
function of other explanatory 
variables.
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c. Uses the equation it created in the first step, combining 
the forecasted independent variable values, to create 
the forecast for the dependent variable.

In the Toledo Gas spreadsheet, the dependent variable is the 
historical residential gas usage. The independent variables are:

� Number of occupation permits issued (new housing starts)

� Average temperature per month

� Unit cost of natural gas

To resume your tutorial:

5. Under Step 5, select the Use Multiple Linear Regression 
option.

The Regression Variables dialog appears.

Figure 1.10  Regression Variables dialog

CB Predictor Note:  This following steps move variables from the All 
Series list to the Dependent and Independent Variables lists. Your example 
might already have these variables in the Dependent and Independent 
variables lists.
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6. Select Usage in the All Series list.

7. Click on >> next to the Dependent Variables list.

The Usage variable moves to the Dependent Variables list.

8. Select Occupancy Permits, Average Temperature, and Cost 
Of Natural Gas Per ccf in the All Series list.

9. Click on >> next to the Independent Variables list.

The variables move to the Independent Variables list.

10. Click on OK.

The Data Attributes tab reappears.

11. Click on Next.

The Method Gallery tab appears.

12. Click on Next again.

The Results tab appears.

Selecting your results

Figure 1.11  Results tab
CB Predictor User Manual 29
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CB Predictor has five ways that you can output your results:

Paste Forecast Pastes the forecasted values to the end of 
your historical data.

Charts Visually graphs historical, fitted, and 
forecasted data values, and a confidence 
interval.

Report Organizes and displays summary 
information, forecast values and a 
confidence interval, charts, and method 
information for any or all of your data 
series.

Results Table Creates a table with all the forecasted 
values, fitted data, and a confidence 
interval. 

Method Table Creates a table listing all the methods tried, 
the error values and statistics for each, and 
parameters for each.

Paste Forecast and Charts are the most common results. The 
other options provide more detailed output that includes 
information you might use for presentations or to investigate 
various forecasting methods.

This tutorial produces more detailed output. To continue with 
the tutorial:

13. Under Step 7, forecast the monthly usage for the next year 
by entering 12 in the field.

14. Select the Paste, Report, and Methods Table result options.

15. In the Title field, type �Toledo Gas Usage Forecast.�
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16. Click on Preferences.

The Preferences dialog appears.

Figure 1.12  Preferences dialog

17. Select the Report tab.

The Report preferences appear.

Figure 1.13  Report Preferences dialog
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18. Uncheck the Chart > Fitted option.

This removes the fitted values from the charts.

19. Under Methods Table, select Three Best from the list and 
unselect the Parameters option.

This removes the method parameters from the report.

20. Click on OK.

The Results tab reappears.

21. Click on Preview.

The Preview Forecast dialog appears.

Previewing results
Before you output results to your spreadsheet, you can preview 
the forecasted values and the best method selected with the 
Preview Forecast dialog.

Figure 1.14  Preview Forecast dialog
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In the Preview Forecast dialog, you can preview the forecasted 
values for all the data series and all the methods run for each. 
After viewing the forecast values for each method, you can also 
override the selected method to use for the final forecasted 
values.

To continue with your tutorial:

22. Select Average Temperature from the Series list.

23. Select Single Exponential Smoothing from the Method list.

The preview changes to show the forecast using single 
exponential smoothing instead of the seasonal additive 
method.

24. Click on Override Best.

This actually changes the forecast to use single exponential 
smoothing instead of the seasonal additive method.

Summary
CB Predictor�s primary job is to create forecasts based on your 
historical data. The program�s method selections appear in the 
Preview dialog. When you override the program�s selections, 
you should carefully analyze your results.

In this example, there were three independent variables that 
combined to forecast the dependent variable: Usage. In the 
tutorial, you overrode the Average Temperature reading to use 
the method Single Exponential Smoothing instead of Seasonal 
Additive. What was the effect?
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Overriding the Average Temperature had a noticeable effect on 
the forecast (but not the fit) of the Usage variable. 

25. Click on Run.

CB Predictor creates:

� The results pasted to the end of your historical data

� On a separate worksheet of your workbook, a report 
listing all the details of the time series forecasts of each 
independent variable and the multiple linear regression 
of the dependent variable

� On a separate worksheet of your workbook, a method 
table (as PivotTables) listing all the time-series 
forecasting methods tried, their parameters, the error 
measures and statistics for each, and the regression 
parameters and statistics

Average Temperature Before Override

Usage After OverrideAverage Temperature After Override

Usage Before Override

Glossary Term:
PivotTable�
An interactive table in Excel. 
You can move rows and 
columns, and filter 
PivotTable data.
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26. Activate the Report worksheet and scroll to the section on 

the Average Temperature variable.

Notice the indications that the method used was an override 
of the best method.

Figure 1.15  Report for Toledo Gas

27. Activate the Methods Table worksheet.

28. Next to the Series button, select Average Temperature.

The table changes to show the parameters and statistics for 
each method of the Average Temperature forecast.
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29. Click on the Series button and drag it to the left of the 
Methods button.

The method table expands to include all four data series. 
When you drop the Series button next to the Methods button, 
the list of methods repeats for each series.

30. Double-click on the Table Items button.

The Excel PivotTable Field dialog appears.

31. In the Hide Items list, select all the items except for Rank.

32. Click on OK.

The method table changes to only show the one parameter: 
Rank. Under Rank, Single Exponential Smoothing is 
highlighted in blue, bold text to show that it was used to 
generate the results. Seasonal Additive, originally the best, is 
still listed as first.

Excel Note:  Excel 95 does not keep the character formatting when you 
change the PivotTable.

33. Move the Methods button to the left of the Series button.

The PivotTable reorganizes to show all the series grouped by 
method type.
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In this chapter
� Time-series forecasting methods

� Error measures

� Multiple linear regression

� Regression statistics

� Historical data statistics

This chapter describes forecasting 
terminology. It defines the time-series 
forecasting methods that CB Predictor 
uses, as well as the other forecasting-related 
terminology. 

This chapter also describes the statistics the 
program generates and the techniques that 
CB Predictor uses to do the calculations 
and select the best-fitting method.
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Forecasting

In the broadest sense, forecasting refers to the act of predicting 
the future, usually for purposes of planning and managing 
resources. There are many scientific approaches to forecasting. 
You can perform �what-if � forecasting by creating and 
simulating with a model, such as with Crystal Ball1, or by 
collecting data over a period of time and analyzing the trends 
and patterns. CB Predictor uses this latter concept, which uses 
the patterns of a time series to forecast future data.

These scientific approaches usually fall into one of several 
categories of forecasting:

time-series Performs time-series analysis on past 
patterns of data to forecast results. This 
works best for stable situations where 
conditions are expected to remain the same. 

regression Forecasts results using past relationships 
between a variable of interest and several 
other variables that might influence it. This 
works best for situations where you need to 
identify the different effects of different 
variables. This category includes multiple 
linear regression.

simulation Randomly generates many different 
scenarios for a model to forecast the 
possible outcomes. This method works best 
where you might not have historical data, 
but you can build the model of your 
situation to analyze its behavior.

qualitative Uses subjective judgement and expert 
opinion to forecast results. These methods 
work best for situations for which there is no 
historical data or model available.

1. CB Predictor is sold both as a stand-alone product and as an inte-
gral tool in Crystal Ball 2000, Professional Edition. For informa-
tion on this product, see our Web site at www.decisioneering.com 
or call us at the number in the README.DOC.
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CB Predictor uses both time-series and multiple linear 
regression for forecasting. Simulation is used by Crystal Ball. 
Each technique and method has advantages and disadvantages 
for particular types of data, so often you might forecast your 
data using several methods and then select the method that 
yields the best results.

Time-series forecasting
Time-series forecasting is a category of forecasting that assumes 
that the historical data is a combination of a pattern and some 
random error. Its goal is to isolate the pattern from the error by 
understanding the pattern�s level, trend and seasonality. You 
can then measure the error using a statistical measurement to 
describe both how well a pattern reproduces historical data and 
to estimate how accurately it forecasts the data into the future. 
For more information on these error measurements, see �Time-
series forecasting error measures� on page 49.

When you select different forecasting methods to try from the 
Methods Gallery, CB Predictor tries all of them. It then ranks 
them according to which method has the lowest error, 
depending on the error selected from the Advanced dialog. The 
method with the lowest error is the best method.

There are two primary techniques of time-series forecasting 
used in CB Predictor. They are:

linear smoothing
Estimates a smooth trend by removing 
extreme data and reducing data 
randomness.

seasonal smoothing
Combines smoothing data with an 
adjustment for seasonal behavior.

Glossary Term:
level�
A starting point for the 
forecast.

Glossary Term:
trend�
A long-term increase or 
decrease in time-series data.

Glossary Term:  
seasonality�
The change that seasonal 
factors cause in a data 
series. For example, if sales 
increase during the 
Christmas season but not 
during the summer, the data 
is seasonal with a one-year 
period.
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Linear smoothing methods

Smoothing models attempt to forecast by removing extreme 
changes in past data. The following methods are available.

Single moving average
Smooths out historical data by averaging 
the last several periods and projecting the 
last average value forward. CB Predictor can 
automatically calculate the optimal number 
of periods to average, or you can select the 
number of periods to average.

This method is best for volatile data with no 
trend or seasonality. It results is a straight, 
flat-line forecast.

Figure 2.1  Typical single moving average data, fit, and 
forecast line

Double moving average
Applies the moving average technique 
twice. Once to the original data, and then to 
the resulting single moving average data. 
This method then uses both sets of 
smoothed data to project forward. CB 
Predictor can automatically calculate the 
optimal number of periods to average, or 
you can select the number of periods to 
average.

This method is best for historical data with 
a trend but no seasonality. It results in a 
straight, sloped-line forecast.
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Figure 2.2  Typical double moving average data, fit, and 
forecast line

CB Predictor Note:  For See Appendix A, �Time-series Forecasting 
Method Formulas,� for more information about the formulas CB Predictor 
uses for the following methods.

Single exponential smoothing (SES)
Weights all of the past data with 
exponentially decreasing weights going into 
the past. In other words, usually the more 
recent data has greater weight. This largely 
overcomes the limitations of moving 
averages or percentage change models. CB 
Predictor can automatically calculate the 
optimal smoothing constant, or you can 
manually define the smoothing constant.

This method is best for volatile data with no 
trend or seasonality. It results in a straight, 
flat-line forecast. 
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Figure 2.3  Typical single exponential smoothing data, fit, 
and forecast line

Holt�s double exponential smoothing (DES)
Double exponential smoothing applies SES 
twice�once to the original data and then to 
the resulting SES data. CB Predictor uses 
Holt�s method for double exponential 
smoothing, which can use a different 
parameter for the second application of the 
SES equation. CB Predictor can 
automatically calculate the optimal 
smoothing constants, or you can manually 
define the smoothing constants.

This method is best for data with a trend but 
no seasonality. It results in a straight, 
sloped-line forecast. 

Figure 2.4  Typical double exponential smoothing data, fit, 
and forecast line
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Nonseasonal smoothing parameters

There are several smoothing parameters used by the 
nonseasonal methods. For the moving average methods, the 
formulas use one parameter: Periods. When performing a 
moving average, you average over a number of periods. For 
single moving average, the number of periods can be any whole 
number between 1 and half the number of data points. For 
double moving average, the number of periods can be any whole 
number between 2 and one-third the number of data points.

For single exponential smoothing, there is one parameter: 
alpha. Alpha (α) is the smoothing constant. The value of alpha 
can be any number between 0 and 1, not inclusive. 

For Holt�s double exponential smoothing, there are two 
parameters: alpha and beta. Alpha is the same smoothing 
constant as described above for single exponential smoothing. 
Beta (β) is also a smoothing constant exactly like alpha, only it is 
used during second smoothing. The value of beta can be any 
number between 0 and 1, not inclusive.

Seasonal smoothing methods
Seasonal exponential smoothing methods extend the simple 
exponential smoothing methods by adding an additional 
component to capture the seasonal behavior of the data. There 
are four seasonal exponential smoothing methods used in CB 
Predictor. 

CB Predictor Note:  For See Appendix A, �Time-series Forecasting 
Method Formulas,� for more information about the formulas CB Predictor 
uses.
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The seasonal smoothing methods available in CB Predictor are:

Seasonal, Additive Smoothing
Calculates a seasonal index for historical 
data that does not have a trend. The 
method produces exponentially smoothed 
values for the level of the forecast and the 
seasonal adjustment to the forecast. The 
seasonal adjustment is added to the 
forecasted level, producing the Seasonal 
Additive forecast.

This method is best for data without trend 
but with seasonality that doesn�t increase 
over time. It results in a curved forecast that 
reproduces the seasonal changes in the 
data. 

Figure 2.5  Typical data, fit, and forecast curve for seasonal, 
additive smoothing without trend

Seasonal, Multiplicative Smoothing
Calculates a seasonal index for historical 
data that does not have a trend. The 
method produces exponentially smoothed 
values for the level of the forecast and the 
seasonal adjustment to the forecast. The 
seasonal adjustment is multiplied by the 
forecasted level, producing the Seasonal 
Multiplicative forecast.

This method is best for data without trend 
but with seasonality that increases or 
decreases over time. It results in a curved 
forecast that reproduces the seasonal 
changes in the data. 
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Figure 2.6  Typical data, fit, and forecast curve for seasonal, 
multiplicative smoothing without trend

Holt-Winters� Additive Seasonal Smoothing
Is an extension of Holt's exponential 
smoothing that captures seasonality. This 
method is based upon three equations that 
can be found in Appendix A. The method 
produces exponentially smoothed values for 
the level of the forecast, the trend of the 
forecast and the seasonal adjustment to the 
forecast. This seasonal additive method 
adds the seasonality factor to the trended 
forecast, producing the Holt-Winters� 
Additive forecast.
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This method is best for data with trend and 
with seasonality that doesn�t increase over 
time. It results in a curved forecast that 
reproduces the seasonal changes in the 
data. 

Figure 2.7  Typical data, fit, and forecast curve for Holt-
Winters� additive smoothing

Holt-Winters� Multiplicative Seasonal Smoothing
Is similar to the Holt-Winters� Additive 
method. This method also calculates 
exponentially smoothed values for level, 
trend and seasonal adjustment to the 
forecast. This method's equations can also 
be found in Appendix A. This seasonal 
multiplicative method multiplies the 
trended forecast by the seasonality, 
producing the Holt-Winters� Multiplicative 
forecast.
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This method is best for data with trend and 
with seasonality that increases over time. It 
results in a curved forecast that reproduces 
the seasonal changes in the data. 

Figure 2.8  Typical data, fit, and forecast curve for Holt-
Winters� multiplicative smoothing

Seasonal smoothing parameters

There are three smoothing parameters used by the seasonal 
methods: alpha, beta, and gamma. 

alpha (α) Smoothing parameter for the level 
component of the forecast. The value of 
alpha can be any number between 0 and 1, 
not inclusive.

beta (β) Smoothing parameter for the trend 
component of the forecast. The value of 
beta can be any number between 0 and 1, 
not inclusive.

gamma (γ) Smoothing parameter for the seasonality 
component of the forecast. The value of 
gamma can be any number between 0 and 1, 
not inclusive.

Each seasonal method uses some or all of these parameters, 
depending on the forecasting method. For example, the 
seasonal additive smoothing method doesn�t account for trend, 
so doesn�t use the beta parameter. 
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Time-series forecasting error measures

One component of every time-series forecast is the data�s 
random error that is not explained by the forecast formula or by 
the trend and seasonal patterns. The error is measured by fitting 
points for the time periods with historical data, and then 
comparing the fitted points to the historical data. 

All the examples are based on the set of data illustrated in the 
chart below. Most of the formulas refer to the actual points (Y) 
and the fitted points ( ). In the chart below, the horizontal axis 
illustrates the time periods (t) and the vertical axis illustrates the 
data point values.

Figure 2.1  Sample data
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CB Predictor measures the error using one of the following 
methods. 

RMSE
RMSE (root mean square error) is an absolute error measure 
that squares the deviations to keep the positive and negative 
deviations from cancelling each other out. This measure also 
tends to exaggerate large errors, which can help eliminate 
methods with large errors.

MAD
MAD (mean absolute deviation) is an absolute error measure 
that originally became very popular (in the days before hand-
held calculators) because it didn�t require the calculation of 
squares or square roots. While it is still fairly reliable and widely 
used, it is most accurate for normally distributed data.

MAPE
MAPE (mean absolute percentage error) is a relative error 
measure that uses absolute values. There are two advantages of 
this measure. First, the absolute values keep the positive and 
negative errors from cancelling each other out. Second, because 
relative errors don�t depend on the scale of the dependent 
variable, this measure lets you compare forecast accuracy 
between differently scaled time-series data.

Time-series forecasting techniques
CB Predictor uses one of four forecasting techniques to perform 
time-series forecasting: standard, simple lead, weighted lead, 
and holdout.
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Standard forecasting

Standard forecasting optimizes the forecasting parameters to 
minimize the error measure between the fit values and the 
historical data for the same period. For example, if your 
historical data was: 

Period 1 2 3 4 5 6 7
Value 472 599 714 892 874 896 890

And your fit data was:

Period 1 2 3 4 5 6 7
Value 488 609 702 888 890 909 870

CB Predictor calculates the RMSE using the differences between 
the historical data and the fit data from the same periods. For 
example:

(472-488)2 + (599-609)2 + (714-702)2 + (892-888)2 + ...

For standard forecasting, CB Predictor optimizes the forecasting 
parameters so that the RMSE calculated in this way is 
minimized.

Simple lead forecasting
Simple lead forecasting optimizes the forecasting parameters to 
minimize the error measure between the historical data and the 
fit values, offset by a specified number of periods (lead). Use this 
forecasting technique when a forecast for some future time 
period has the greatest importance, more so than the forecasts 
for the previous or later periods.

For example, your company must order extremely expensive 
manufacturing components two months in advance, making any 
forecast for two months out the most important. For the same 
historical and fit example data described above in Standard 
Forecasting, CB Predictor calculates the RMSE using the 
difference between the historical data and the fit data from an 
offset number of periods (lead). With a lead of 2, the differences 
used in the RMSE calculation are:

(472-702)2 + (599-888)2 + (714-890)2 + (892-909)2 + ...
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For simple lead forecasting, CB Predictor optimizes the 
forecasting parameters so that the RMSE calculated in this way 
is minimized.

Weighted lead forecasting
Weighted lead forecasting optimizes the forecasting parameters 
to minimize the average error measure between the historical 
data and the fit values, offset by 0, 1, 2, etc., up to the specified 
number of periods (weighted lead). It uses the simple lead 
technique for several lead periods and then averages the 
forecast over the periods, optimizing this average value. Use this 
technique when the future forecast for several periods is most 
important.

For example, your company must order extremely expensive 
manufacturing components zero, one, and two months in 
advance, making any forecast for all the time periods up to two 
months out the most important. For the same historical and fit 
example data described above in Standard Forecasting, CB 
Predictor calculates the RMSE for each lead up to the weighted 
lead using the difference between the historical data and the fit 
data from a set of offset periods (individual leads). With a 
weighted lead of 2, the differences used in the RMSE 
calculations are:

(472-488)2 + (599-609)2 + (714-702)2 + (892-888)2 + ... (lead 
of 0)

(472-609)2 + (599-702)2 + (714-888)2 + (892-890)2 + ... (lead 
of 1)

(472-702)2 + (599-888)2 + (714-890)2 + (892-909)2 + ... (lead 
of 2)

Then CB Predictor averages the RMSE for the lead of 0, the lead 
of 1, and the lead of 2. For weighted lead forecasting, CB 
Predictor optimizes the forecasting parameters to minimize the 
average of the RMSE calculations.

Holdout
Holdout forecasting:

1. Removes the last few data points of your historical data.
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2. Calculates the fit and forecast points using the remaining 

historical data.

3. Compares the error between the forecasted points and their 
corresponding, excluded, historical data points.

4. Changes the parameters to minimize the error between the 
forecasted points and the excluded points.

CB Predictor determines the optimal forecast parameters using 
only the non-holdout set of data.

CB Predictor Note:  If you have a small amount of data and want to use 
seasonal forecasting methods, using the Holdout technique might restrict 
you to non-seasonal methods.

Statistical Note:  For more information on the holdout technique and 
when to use it effectively, see the Makridakis, Wheelwright, and Hyndman 
reference in the bibliography.

Time-series forecasting statistics

Theil�s U
Theil�s U statistic is a relative error measure that compares the 
forecasted results with a näive forecast. It also squares the 
deviations to give more weight to large errors and to exaggerate 
errors, which can help eliminate methods with large errors.

Theil�s U statistic Means:

Less than 1 The forecasting technique is better 
than guessing.

1 The forecasting technique is about as 
good as guessing.

More than 1 The forecasting technique is worse 
than guessing.

Glossary Term:
näive forecast�
A forecast obtained with 
minimal effort based only on 
the most recent data. E.g., 
Using the last data point to 
forecast the next period.
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Multiple linear regression
Multiple linear regression is used for data where one data series 
(the dependent variable) is a function of, or depends on, other 
data series (the independent variables). For example, the yield 
of a lettuce crop depends on the amount of water provided, the 
hours of sunlight each day, and the amount of fertilizer used.

The goal of multiple linear regression is to find an equation that 
most closely matches the historical data. The word �multiple� 
indicates that you can use more than one independent variable 
to define your dependent variable in the regression equation. 
The word �linear� indicates that the regression equation is a 
linear equation. 

The linear equation describes how the independent variables 
(x1, x2, x3,...) combine to define the single dependent variable 
(y). Multiple linear regression finds the coefficients for the 
equation:

y = b0 + b1x1 + b2x2 + b3x3 + ... + e

where b1, b2, and b3, are the coefficients of the independent 
variables, b0 is the y-intercept, and e is the error. 

If there is only one independent variable, the equation defines 
a straight line. This uses a special case of multiple linear 
regression called simple linear regression, with the equation:

y = b0 + b1x + e

where b0 is where on the graph the line crosses the y axis, x is the 
independent variable, and e is the error. When the regression 
equation has only two independent variables, it defines a plane. 
When the regression equation has more than two independent 
variables, it defines a hyperplane. 

To find the coefficients of these equations, CB Predictor uses 
singular value decomposition. For more information on this 
technique, see �Singular value decomposition� on page 156. 

Glossary Term:
linear equation�
An equation with only linear 
terms. A linear equation has 
no terms containing variables 
with exponents or variables 
multiplied by each other.

Glossary Term:
hyperplane�
A geometric plane that spans 
more than two dimensions.

Glossary Term:
singular value 
decomposition�
A method that solves a set 
of equations for the 
coefficients of a regression 
equation.
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Figure 2.2  Parts of a scatter plot

Regression methods
CB Predictor uses one of three regression methods: standard 
regression, forward stepwise regression, and iterative stepwise 
regression.

Standard regression
Standard regression performs multiple linear regression, 
generating regression coefficients for each independent 
variable you specify, no matter how significant. 

Forward stepwise regression
Forward stepwise regression adds one independent variable at a 
time to the multiple linear regression equation, starting with the 
independent variable with the most significant probability of the 
correlation (partial F statistic). It then recalculates the partial F 
statistic for the remaining independent variables, taking the 
existing regression equation into consideration.

CB Predictor Note:  The resulting multiple linear regression equation 
will always have at least one independent variable.
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Forward stepwise regression continues to add independent 
variables until either:

� It runs out of independent variables

� It reaches one of the selected stopping criteria in the 
Stepwise Options dialog

� The number of included independent variables reaches one-
third the number of data points in the series

There are two stopping criteria:

R-squared Stops the stepwise regression if the 
difference between a specified statistic 
(either R2 or adjusted R2) for the previous 
and new regression solutions is below a 
threshold value. When this happens, CB 
Predictor does not use the last independent 
variable.

For example, the third step of a stepwise 
regression results in an R2 value of 0.81, and 
the fourth step adds another independent 
variable and results in an R2 value is 0.83. 
The difference between the R2 values is 
0.02.

If the Threshold value is 0.03, CB Predictor 
returns to the regression equation for the 
third step and stops the stepwise regression.

F-test significance
Stops the stepwise regression if the 
probability of the F statistic for a new 
solution is above a maximum value.

For example, if you set the maximum 
probability to 0.05, and the F statistic for the 
fourth step of a stepwise regression results 
in a probability of 0.08, CB Predictor 
returns to the regression equation for the 
third step and stops the stepwise regression.

Iterative stepwise regression
Iterative stepwise regression adds or removes one independent 
variable at a time to or from the multiple linear regression 
equation.
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To perform iterative stepwise regression, CB Predictor:

1. Calculates the partial F statistic for each independent 
variable.

2. Adds the independent variable with the most significant 
correlation (partial F statistic). 

3. Checks the partial F statistic of the independent variables in 
the regression equation to see if any became insignificant 
(have a probability below the minimum) with the addition of 
the latest independent variable.

4. Removes the least significant of any insignificant 
independent variables one at a time.

5. Repeat step 3 until no insignificant variables remain in the 
regression equation.

6. Repeat steps 1 through 5 until:

� The model runs out of independent variables

� The regression reaches one of the stopping criteria (see 
the previous section for information on how the stopping 
criteria work)

� The same independent variable is added and then 
removed

CB Predictor Note:  The resulting equation will always have at least one 
independent variable.

Regression statistics
Once CB Predictor finds the regression equation, it calculates 
several statistics to help you evaluate the regression. See 
Appendix D, �Regression Statistic Formulas,� for more 
information on the formulas CB Predictor uses to calculate these 
statistics.
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R2

Coefficient of determination. This statistic indicates the 
percentage of the variability of the dependent variable that the 
regression equation explains. 

For example, an R2 of 0.36 indicates that the regression 
equation accounts for 36% of the variability of the dependent 
variable.

Adjusted R2

Corrects R2 to account for the degrees of freedom in the data. 
In other words, the more data points you have, the more 
universal the regression equation is. However, if you only have 
the same number of data points as variables, the R2 might 
appear deceivingly high. This statistic corrects for that.

For example, the R2 for one equation might be very high, 
indicating that the equation accounted for almost all the error 
in the data. However, this value might be inflated if the number 
of data points was insufficient to calculate a universal regression 
equation.

SSE
Sum of square deviations. The least squares technique for 
estimating regression coefficients minimizes this statistic, which 
measures the error not eliminated by the regression line. 

For any line drawn through a scatter plot of data, there are a 
number of different ways to determine which line fits the data 
best. One method is to compare the fit of lines is to calculate the 
SSE (sum of the squared errors) for each line. The lower the 
SSE, the better the fit of the line to the data. 

F statistic
Tests the significance of the regression equation as measured by 
R2. If this value is significant, it means that the regression 
equation does account for some of the variability of the 
dependent variable.
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t statistic

Tests the significance of the relationship between the 
coefficients of the dependent variable and the individual 
independent variable, in the presence of the other independent 
variables. If this value is significant, it means that the 
independent variable does contribute to the dependent 
variable.

P
Indicates the probability of your calculated F or t statistic being 
as large as it is (or larger) by chance. A low P value is good and 
means that the F statistic is not coincidental and therefore is 
significant. A significant F statistic means that the relationship 
between the dependent variable and the combination of 
independent variables is significant.

Generally, you want your P to be less than 0.05.

Durbin-Watson
Detects autocorrelation at lag 1. This means that each time-
series value influences the next value. This is the most common 
type of autocorrelation.

Avoid using independent variables that have errors with a 
strong positive or negative correlation, since this can lead to an 
incorrect forecast for the dependent variable.

The value of this statistic can be any value between 0 and 4. 
Values indicate slow-moving, none, or fast-moving 
autocorrelation:

Glossary Term:
autocorrelation�
Describes a relationship or 
correlation between values 
of the same data series at 
different time periods.

Glossary Term:
lag�
Defines the offset when 
comparing a data series with 
itself. For autocorrelation, 
this refers to the offset of 
data that you choose when 
correlating a data series with 
itself.
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Historical data statistics
CB Predictor automatically calculates the following statistics for 
historical data series:

mean
The mean of a set of values is found by adding the values and 
dividing their sum by the number of values. The term �average� 
usually refers to the mean. For example, 5.2 is the mean or 
average of 1, 3, 6, 7, and 9.

standard deviation
The standard deviation is the square root of the variance for a 
distribution. Like the variance, it is a measure of dispersion 
about the mean and is useful for describing the �average� 
deviation.

For example, you can calculate the standard deviation of the 
values 1, 3, 6, 7, and 9 by finding the square root of the variance 
that is calculated in the variance example below.

Durbin-Watson 
statistic

Means:

Less than 1 The errors are positively correlated. So 
an increase in one period follows an 
increase in the previous period.

2 No autocorrelation.

More than 3 The errors are negatively correlated. 
So an increase in one period follows an 
decrease in the previous period.
60 CB Predictor User Manual 



1

The standard deviation, denoted as , is calculated from the 
variance as follows:

where the variance is a measure of the dispersion, or spread, of 
a set of values about the mean. When values are close to the 
mean, the variance is small. When values are widely scattered 
about the mean, the variance is larger.

To calculate the variance of a set of values:

1. Find the mean or average.

2. For each value, calculate the difference between the value 
and the mean.

3. Square these differences.

4. Divide by n-1, where n is the number of differences.

For example, suppose your values are 1, 3, 6, 7, and 9. The mean 
is 5.2. The variance, denoted by , is calculated as follows:

minimum
The minimum is the smallest value in the data range.

maximum
The maximum is the largest value in the data range.

s

s 10.2 3.19= =

s2

s2 1 5.2�( )2 3 5.2�( )2 6 5.2�( )2 7 5.2�( )2 9 5.2�( )2+ + + +
5 1�

-------------------------------------------------------------------------------------------------------------------------------------------------=

40.8
4

---------- 10.2==
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Ljung-Box
Measures whether a set of autocorrelations are significantly 
different than a set of autocorrelations that are all zero. The 
Ljung-Box statistic is calculates as follows:

where:

Q� Is the Ljung-Box statistic.

n Is the amount of data in the data sample.

h Is the size of the set of autocorrelations used 
to calculate the statistic.

rk Is the autocorrelation with a lag of k.

p Is the probability that the set of 
autocorrelations is the same as a set of 
autocorrelations which are all 0.

The size of the set of autocorrelations is equal to 1/3 the size of 
the data sample or 100, if the sample is larger than 300.

Q' n n 2+( )
rk

2

n k�( )
----------------

k 1=

h

∑=
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Forecasting with 
CB Predictor



In this chapter
� Set up your model

� Perform time-series forecasting

� Perform multiple linear regression 
forecasting

� Analyze your data

� Customize your results

This chapter contains detailed procedures 
for using CB Predictor. It describes how to 
forecast using both time-series forecasting 
methods and multiple linear regression. It 
also describes all the options you can 
choose for your results.
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Overview

When you use CB Predictor for the first time, there are several 
things you will need to do:

1. Create your Excel spreadsheet with your historical data.

2. Start CB Predictor.

3. Run CB Predictor.

4. Analyze your results.

5. Customize your results.

This chapter describes how to complete each of these steps to 
make forecasting your historical data an easy task.

Creating the spreadsheet
Before using CB Predictor, you must create an Excel 
spreadsheet with your historical data. Creating a spreadsheet for 
use with CB Predictor is easy. The spreadsheet only needs to 
include:

� Optionally, a descriptive spreadsheet title.

� Optionally, a date (or other time period, such as Q4-1999) 
column or row, either at the top or along the left side of your 
data. If you format your dates as Excel dates, CB Predictor�s 
Intelligent Input can find the dates, extend them with the 
forecasted values, and use them as labels on charts.

� Historical data, spaced equal time periods apart, in columns 
or rows adjacent to the date column or row. You can use CB 
Predictor to simultaneously forecast from one to 10,000 
adjacent historical data series.

Excel Note:  Excel only has 256 possible columns, compared to 16,000 
or 65,000 possible rows (depending on your version). So if you have a 
large number of historical data points, organize your data in columns. If 
you have a large number of data series, organize your data in rows.

To produce a reasonable forecast, you should have at least 6 
historical data values. To use seasonal forecasting methods, 
you need at least two seasons of data.
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� Optionally, headings for each data column or row, such as 
SKU 23442, Gas Usage, or Interest Rate.

The Toledo Gas spreadsheet has all these components.

Figure 3.1  Example spreadsheet

Starting CB Predictor
CB Predictor is an Excel add-in that you can load:

� For stand-alone CB Predictor, automatically when you start 
Excel or manually only when you need to use it. 

� For CB Predictor as part of Crystal Ball 2000, Professional 
Edition, automatically when you start Crystal Ball.

After you load this add-in, to start the CB Predictor wizard (for 
stand-alone CB Predictor):

� In Excel, select Tools > CB Predictor 

� Click on the CB Predictor wizard icon in the toolbar

� Type <Ctrl>-t
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To start the CB Predictor wizard (for CB Predictor as part of 
Crystal Ball 2000, Professional Edition):

� In Excel, select CBTools > CB Predictor 

� Click on the CB Predictor wizard icon in the toolbar

� Type <Ctrl>-t

Crystal Ball Note:  The wizard icon does not appear in the Crystal Ball 
toolbar, and the <Ctrl>-t shortcut doesn�t work until after the first time 
you select CB Predictor from the CBTools menu.

Crystal Ball Note:  For information on loading stand-alone CB 
Predictor and Crystal Ball simultaneously, see �Loading stand-alone CB 
Predictor and Crystal Ball� on page 133.

Loading the program automatically (stand-alone only)
When you installed CB Predictor, the installer asked you to 
select whether to start CB Predictor automatically whenever you 
started Excel. If you selected Yes, then CB Predictor already 
loads automatically. 

If you selected No, then you still can set up Excel to load stand-
alone CB Predictor automatically. 

To load stand-alone CB Predictor automatically:

1. Start Excel.

2. In Excel, select Tools > Add-ins.

The Add-ins dialog appears.

3. If CB Predictor appears in the add-ins list unchecked, 
select it.

Excel Note:  If it is already checked, CB Predictor already loaded with 
Excel.
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4. If CB Predictor doesn�t appear in the add-ins list:

a. Click on Browse.

b. Find your CB Predictor installation folder.

CB Predictor Note:  The default installation folder is CB Predictor, 
under the Program Files folder (e.g., C:\Program Files\CB Predictor).

c. Select the file cbpred.xla.

d. Click on OK.

CB Predictor appears checked in the add-ins list.

5. Click on OK.

CB Predictor starts, opening the CB Predictor toolbar.

Loading the program manually (stand-alone only)
To load the stand-alone version of the program manually, you 
must either start CB Predictor from:

� The CB Predictor icon on the toolbar

� Start > Programs > CB Predictor > CB Predictor

CB Predictor Note:  If you already have Excel running, this launches an 
additional copy of Excel with CB Predictor loaded.

Running CB Predictor
After you create your Excel spreadsheet with your historical 
data, forecasting data using CB Predictor follows a 10-step 
process:

1. Select a cell range with your historical data to forecast.

2. Specify your data arrangement.

3. View a graph of your historical data to identify any 
seasonality or trend and to see summary statistics.

4. Identify your time periods, whether your data has 
seasonality, and, if so, how long your season is.
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5. Set whether you want to use multiple linear regression to 

forecast any variables.

6. Select the time-series forecast methods to try for each 
variable.

7. Enter the number of periods you want to forecast.

8. Select a confidence interval to calculate or display with your 
forecasted values.

9. Select the results you want.

10. Preview and run the forecast, creating your results.

CB Predictor leads you through these steps using the CB 
Predictor wizard, but you can also go directly to any of these 
steps to change methods or select different options and 
reforecast data.

Also, many of these steps might be done automatically by CB 
Predictor. For example, CB Predictor�s Intelligent Input can 
find and select your data, its arrangement, and the data units. 
And you can skip many other steps if the settings are already 
what you want. For example, all the time-series forecasting 
methods are selected by default, and that is probably how most 
users will leave them.

Selecting historical data
When you select your historical data, you must identify the Excel 
cells that contain your data, including dates and headers, and 
set options to identify any dates, headers, and orientation in 
your data. 

To produce a reasonable forecast, you should have a minimum 
number of historical data points. CB Predictor imposes several 
requirements defining a minimum number of points to use to 
create a forecast. The bare minimum is 5. However, other 
limitations include:

� Single moving average requires that the number of historical 
data points is twice the number of points to forecast 

� Double moving average requires that the number of 
historical data points be three times the number of points to 
forecast (or at least 6, whichever is higher) 
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� To use seasonal methods, you must have at least two seasons 
of historical data. 

� For multiple linear regression, the number of historical data 
points must be three times the number of independent 
variables (counting the included constant as an independent 
variable)

� To lag an independent variable in multiple linear regression, 
the number of historical data points must be three times the 
lag.

If your data has empty cells in the middle of your data series, CB 
Predictor returns an error. CB Predictor treats zeros in data 
series as data values. If you are trying to forecast several data 
series at once, your data series do not have to start at the same 
time period. However, all the data series must end at the same 
time period. 

When you initially open a spreadsheet, there are three ways to 
select the historical data to forecast: 

� Use CB Predictor�s Intelligent Input

� Select your data before you start the wizard

� Select your data after you start the wizard

The easiest way to select data is to select one cell somewhere in 
your continuous data range before you start the CB Predictor 
wizard. When you start the wizard, CB Predictor�s Intelligent 
Input searches for all the adjacent cells with numbers, dates, and 
headers, and makes some other assumptions about your input 
data, such as whether your data is in rows or columns. This often 
completes most of the fields and options on the Input Data tab.

The second way is to select your historical data (including 
headers and dates) before you start the wizard.

The third way is to start the wizard with no data, date, or header 
cells selected. The Input Data tab of the wizard appears with the 
Range field blank. At this point, you must select your historical 
data manually.
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To select historical data manually from the Input Data tab:

1. Start CB Predictor.

The Input Data tab of the wizard dialog appears. For more 
information on this dialog, see �Input Data tab� on page 73.

2. Under Step 1, in the Range field, either type a range name 
(if defined), enter the range of cells with the historical data, 
including any headers (e.g., A4:B42), or:

a. Click on Select.

The Select Range dialog replaces the wizard dialog.

b. Select the cells with the historical data, including any 
cells with headers and dates.

c. Click on OK to return to the wizard dialog.

The selected range appears in the Range field.

Specifying data arrangement
No matter which selection method you use, you must also 
specify your data arrangement to help CB Predictor identify 
whether you have dates and headers adjacent to your data series 
and whether your data is in rows or columns. If you used the 
Intelligent Input to select your data, these options should 
already be set correctly.

To set options:

1. Under Step 2, if your historical data is in:

� Rows, select Data In Rows

� Columns, select Data In Columns

2. If you have headers (titles) at the top of your columns or to 
the left of your rows, select the First Row (Column) Has 
Headers option.

3. If your first column or row lists the dates or time periods for 
your data series, select the First Column (Row) Has Dates 
option.
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Viewing your historical data
As you progress through the wizard, you will need to know if 
your data is seasonal and, if so, what the season is. If you do not 
already have a feel for the behavior of your data, you might want 
to view your selected, historical data before you continue.

To view a graph of your historical data:

1. Under Step 3, click on View Data.

The View Historical Data dialog appears. If your data has a 
recurring pattern, your data might be seasonal, and you 
should note how many dates or time periods are in one cycle 
of the pattern.

2. If you selected more than one historical data series, change 
the graph to view another data series by selecting it from the 
Series list.

CB Predictor Note:  When the Series list is selected, you can also use the 
up and down arrows to scroll through the list.

3. To see the three highest autocorrelations and the Ljung-
Box statistic, select Autocorrelations from the View list.

For information on the Ljung-Box statistic, see �Ljung-Box� 
on page 62.

4. Click on Close.

The Input Data tab reappears.
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Input Data tab

The Input Data tab of the wizard dialog lets you define your 
input data. 

Figure 3.2  Input Data tab of the wizard dialog

The fields and buttons are:

Range Lists the Excel cell range that contains the 
historical data to forecast, any date fields, 
and any header fields.

If you select one cell before you start the 
wizard, CB Predictor�s Intelligent Input 
automatically guesses the input range based 
on the continuously filled cells around the 
selected cell. If you select a range of cells 
before you start the wizard, that range 
appears in the Range field. If you do not 
select a cell or if you select an empty cell 
when you start the wizard, you must select 
your range using the Select button.

Select Hides the wizard dialog and lets you select a 
cell range for the Range field. Use this 
button to select a different cell range than 
the one in the Range field.
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This button brings up a small Select Range 
dialog to let you select the cells directly from 
the spreadsheet. After selecting the cells, 
click on OK to return to the Input Data tab.

Data In Rows Indicates that your data is in rows. If you 
select one cell in your data range before you 
start the wizard, CB Predictor�s Intelligent 
Input automatically guesses that your data 
is in the direction with more cells. If the 
selected cell when you start the wizard is 
blank, this is the default.

Data In Columns
Indicates that your data is in columns. If you 
select one cell in your data range before you 
start the wizard, CB Predictor�s Intelligent 
Input automatically guesses that your data 
is in the direction with more cells.

First Row (Column) Has Headers
Indicates whether your data has a title or 
header cell at the top of each column (if 
your data is in columns) or to the left of each 
row (if your data is in rows). If you select one 
cell in your data range before you start the 
wizard, and CB Predictor�s Intelligent Input 
finds text cells at the heads of your data, it 
automatically selects this option. 

First Column (Row) Has Dates
Indicates whether your data has a first row 
or column for dates. CB Predictor only 
recognizes dates in cells that are formatted 
as Excel dates. If you select one cell in your 
data range before you start the wizard, and 
CB Predictor�s Intelligent Input finds 
formatted date cells in the first row or 
column, it automatically selects this option.

View Data Opens the View Historical Data dialog and 
plots your historical data. You can use this to 
estimate whether your data has any trend or 
seasonality, and what your seasonal period 
is.
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The following buttons appear on all the wizard dialogs:

Preview Opens the Preview dialog. For more 
information on this dialog, see �Preview 
Forecast dialog� on page 111.

Run Forecasts the selected historical data. The 
program forecasts the data and provides 
input using all the methods and options 
already selected.

View Historical Data dialog

The View Historical Data dialog lets you view your data to detect 
the behavior and any seasonality. There are two very different 
views in this dialog: Raw Data and Autocorrelations. 

View Historical Data - Raw Data view

Figure 3.3  View Historical Data dialog - Raw Data view

The fields and buttons on this dialog for the Raw Data view are:

Series Lists all the data series in your spreadsheet. 
The selected series appears in the chart.

View Selects whether to display raw data or 
autocorrelation analysis data in the chart, 
each with corresponding statistics in the 
Statistics field.
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Statistics Lists the number of values, mean, standard 
deviation, minimum, and maximum values 
for the selected series.

chart Displays the historical data for the selected 
series.

View Historical Data - Autocorrelations view

The Autocorrelations view of this dialog lets you display 
autocorrelations to detect whether the data has any seasonality. 
The three most significant autocorrelation coefficients (up to a 
lag of one-third of the number of data points) appear in the 
Statistics area. 

The lag represents the number of data periods that the data is 
offset with the original data before calculating the correlation 
coefficient. For example, a lag of 12 corresponds with 
correlating the data with itself, offset by 12 periods. In other 
words, the correlation of the first data item with the thirteenth 
data item, the second data item with the fourteenth data item, 
etc. The value of Prob indicates the significance of the lag.

If the probability of the Ljung-Box statistic is less than 0.05, the 
set of autocorrelations is significant and your data is probably 
seasonal. The seasonality is indicated by the autocorrelation lag. 
For example, if one of the top three lags is 12, and has a 
probability of less than 0.001, your data likely has a seasonality 
of 12 periods.
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Figure 3.4  View Historical Data dialog - Autocorrelations 
view

The fields and buttons on this dialog for the Autocorrelations 
view are:

Series Lists all the data series in your spreadsheet. 
The selected series appears in the chart.

View Selects whether to display raw data or 
autocorrelation analysis data in the chart, 
each with corresponding statistics in the 
Statistics field.

Statistics Lists the number of values, the Ljung-Box 
statistic, and the top three autocorrelations 
detected for the selected series, with the 
lags and associated probabilities.

chart Displays the autocorrelation coefficients at 
different lags for the selected series.

Zoom In Increases the magnification of the data 
graph, showing less data points.

Zooming is only available in the 
Autocorrelation view.

Zoom Out Decreases the magnification of the data 
graph, showing more data points.
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Zooming is only available in the 
Autocorrelation view.

Identifying time periods and seasonality
You need to identify your time periods and seasonality for CB 
Predictor. 

To identify your data�s time periods and seasonality:

1. In the Input Data tab, Click on Next.

The Data Attributes tab appears. For more information on 
this tab, see �Data Attributes tab� on page 81.

2. Under Step 4, identify the time period for your data values.

For example, if your data represents monthly numbers, select 
months.

3. Either:

� If any of your data series is seasonal, select the 
Seasonality option and enter the number of time periods 
it takes before you data pattern repeats. You must have at 
least two seasons of data to use the seasonal methods. 

This number is usually the number of periods per year. 
For example, if you have 24 monthly data points, and 
your data has peaks every December, your seasonality 
(repeating pattern) has a period of one year, or 12 
months.

CB Predictor Note:  You can also view the autocorrelations on the View 
Historical Data dialog to discover how many periods you have in a season.

� If none of your data is seasonal, select the No Seasonality 
option.

� If you are forecasting multiple data series and each has a 
different seasonality, you must forecast each individually.
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Using multiple linear regression

If you know that some variables affect a particular variable of 
interest, you should use multiple linear regression as the 
forecasting method for that particular dependent variable. For 
example, summer temperatures affect electricity usage because 
as it gets hotter, more people run their air conditioning. This 
means that electricity usage (the dependent variable) is 
dependent on the temperature (an independent variable).

CB Predictor Note:  The �multiple� in multiple linear regression 
represents the fact that you can have more than one independent variable.

To forecast a dependent variable using regression, CB Predictor:

a. Creates an equation that defines the mathematical 
relationship between the independent variables and 
your dependent variable. This is the regression 
equation.

b. Forecasts each independent variable by running all the 
selected time-series forecasting methods for each one 
and using the best method for each.

c. Calculates the regression equation with the forecasted 
independent variable values to create the forecast for 
the dependent variable.

This process of generating the regression equation, forecasting 
the independent variables, and calculating the results to forecast 
the dependent variable in one easy step is called HyperCasting�.

To use multiple linear regression:

1. Under Step 5, if one or more variables depend on other 
variables that you have, select the Use Multiple Linear 
Regression option.

The Regression Variables dialog appears.

2. Select the name of your dependent variable in the All Series 
list.

You can have more than one dependent variable. CB 
Predictor will forecast them all, one at a time, as functions of 
all the same independent variables.

Glossary Term:
variables�
In regression, data series are 
also called variables.
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3. Click on >> next to the Dependent Variables list.

The variable moves to the Dependent Variables list.

4. Select the names of your independent variables in the All 
Series list.

To select multiple names, either hold down the <Ctrl> or 
<Shift> key or drag the mouse over the list.

5. Click on >> next to the Independent Variables list.

The variables move to the Independent Variables list.

6. To lag independent variable data by a number of time 
periods:

a. Select a variable name from the Independent Variable 
list.

b. Enter a number in the Lag field at the bottom of the list.

c. Repeat for any other independent variables you want to 
lag.

7. For any independent variables that you don�t want to 
forecast:

a. Select the variable name from the Independent Variable 
list.

b. Select the Do Not Forecast option at the bottom of the 
list.

c. Repeat for any other independent variables you do not 
want CB Predictor to forecast.

8. Click on OK.

The Data Attributes tab reappears.

9. Select the regression method to use, either standard, 
forward stepwise, or iterative stepwise.

10. If you selected a stepwise regression, you can set options 
associated with stepwise regression.

a. Click on Stepwise Options.

The Stepwise Options dialog appears.

b. Set the options. For more information on these options, 
see �Regression methods� on page 55.
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c. Click on OK.

You return to the wizard.

11. If you want CB Predictor to calculate the regression 
equation without a constant (to force the resulting equation 
to pass through the mathematical origin), unselect the 
Include Constant option.

Data Attributes tab

The Data Attributes tab lets you specify the seasonality of your 
historical data and use multiple linear regression to forecast any 
variables that depend on other variable data you might have.

Figure 3.5  Data Attributes tab of the wizard

The fields, options, and buttons in this tab are:

Data Is In Lets you select what kind of time periods 
your data points represent. For example, 
your data might be in hours, days, weeks, 
months, or quarters. If your data has a time 
period that is not listed, you can type in 
your own and CB Predictor will do the rest.

The default is Periods.
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Seasonality Indicates that your data is seasonal and sets 
the number of data points that are in a 
season (the period of time it takes your data 
pattern to repeat). For example, if you 
indicated that your seasonal sales data is in 
months, and you think that your sales 
pattern repeats every year, you should 
indicate that you have a seasonality of 12 
months.

CB Predictor enters a default value in this 
field based on the time period listed in the 
Data Is In field.

No Seasonality Indicates that your data is not seasonal. If 
you select this option, CB Predictor does 
not use the seasonal methods in the Method 
Gallery.

Use Multiple Linear Regression
Specifies that you have at least one data 
series that depends on one or more other 
data series. Selecting this option 
automatically opens the Regression 
Variables dialog. For more information, see 
�Regression Variables dialog� on page 83.

For example, if you want to predict national 
sales of big-screen televisions, you might 
know that it depends on National Personal 
Income and Savings and Loans Deposits. 
Therefore, you should use multiple linear 
regression as the forecasting method for the 
sales of big-screen televisions.

Select Variables
Opens the Regression Variables dialog, 
which lets you identify your dependent and 
independent variables. 

Method Sets what regression method to use. The 
choices are standard, forward stepwise, and 
iterative stepwise. 

For more information on these regression 
methods, see �Regression methods� on 
page 55.

The default is Standard.
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Stepwise Options

Opens the Stepwise Options dialog. If you 
select a stepwise regression method, you can 
use this button to set the stopping criteria 
for the stepwise regression or the partial 
F statistic significance to use for the steps. 

For more information, see �Stepwise 
Options dialog� on page 85.

Include Constant
Sets whether CB Predictor must generate a 
regression equation with or without a 
constant. No constant indicates that the y-
intercept of the regression line is 0.

The default is to use a constant. Only turn 
off this option if the dependent variable is 
zero when all independent variables are 
zero.

Regression Variables dialog

You can use the Regression Variables dialog to select the 
dependent and independent variables for forecasting with 
multiple linear regression, and to set options for independent 
variable series. 

Figure 3.6  Regression Variables dialog
CB Predictor User Manual 83



Chapter 3 Forecasting with CB Predictor
The fields, options, and buttons in this dialog are:

All Series Lists all the variables on your spreadsheet 
that are not designated as either dependent 
or independent variables.

Dependent Variables
Lists all the variables selected as being 
dependent on other variables. You must 
select at least one dependent variable.

Independent Variables
Lists all the variables selected as having 
influence on dependent variables. You must 
select at least one independent variable if 
you selected a dependent variable.

CB Predictor Note:  You don�t have to define all your variables as either 
dependent or independent. Just leave variables that are not involved in the 
regression in the All Series list.

Lag Sets the number of periods that you want 
this independent variable to lag behind the 
dependent variable for calculating the 
regression equation.

The default is 0.

Do Not Forecast
Sets whether to forecast the independent 
variable during Hypercasting. You might 
not want to forecast some independent 
variables if you have future values 
determined in some external way and 
already have those values in your 
spreadsheet before forecasting.

The default is off, meaning that CB 
Predictor forecasts all independent 
variables during Hypercasting.

>> Moves the variables selected in the All 
Series list to either the corresponding 
Dependent Variables or Independent 
Variables list.

<< Moves the variables selected in either the 
Dependent Variables or Independent 
Variables list to the All Series list.
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Stepwise Options dialog

You can set options that control how CB Predictor does stepwise 
regression in the Stepwise Options dialog.

Figure 3.7  Stepwise Options dialog

The fields, options, and buttons in this dialog are:

R-squared Stops the stepwise regression if the 
difference between a specified statistic 
(either R2 or adjusted R2) for the previous 
and new regression solutions is below a 
threshold value. When this happens, CB 
Predictor does not use the new regression 
solution.

By default, this stopping criteria is on and 
uses R-squared as the statistic. If this option 
and the F statistic significance are both on, 
the stepwise regression stops when it 
reaches either criteria.
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Threshold Sets the minimum increment required 
between the R2 (or adjusted R2) of the last 
step and the R2 (or adjusted R2) of the new 
step to continue with the stepwise 
regression.

The default is 0.001.

F-test significance
Stops the stepwise regression if the 
probability of the F statistic for a new 
solution is above a maximum value.

By default, this stopping criteria is on. If 
this option and the R-squared option are 
both on, the stepwise regression stops when 
it reaches either criteria.

Probability Sets the maximum probability required for 
the F statistic to continue with the stepwise 
regression. 

The default is 0.05.

Probability To Add
Sets the maximum probability of the 
correlation (partial F statistic) of the 
independent variable required to add the 
variable to the regression equation.

The default is 0.05.

Statistical Note:  When dealing with statistical tests, smaller probabilities 
indicate more significance.

Probability To Remove
Sets the minimum probability of the 
correlation (partial F statistic) of the 
independent variable required to remove 
the variable from the regression equation.

The default is 0.10.

CB Predictor Note:  This option is only available with iterative stepwise 
regression.

CB Predictor Note:  The Probability To Remove must be at least 0.05 
higher than the Probability To Add.
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Selecting time-series forecasting methods

You can forecast historical data using many different time-series 
forecasting methods. Some methods are designed to work best 
for certain types of data:

� Seasonal data (increases or decreases in a regularly 
reoccurring pattern over time)

� Trend data (is consistently increasing or decreasing over 
time)

Figure 3.8  Seasonal data and data with a trend

For time-series forecasting, any of the time-series forecasting 
methods should work with different amounts of success. 
However, each method has its own �specialty,� as described 
below.

Seasonal Data Data With A Trend

No trend or 
seasonality Trend only Seasonality only

Both trend and 
seasonality

Single 
Exponential 
Smoothing

Holt�s Double 
Exponential 
Smoothing

Seasonal Additive Holt-Winters� 
Additive

Single Moving 
Average

Double Moving 
Average

Seasonal 
Multiplicative 

Holt-Winters� 
Multiplicative
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In addition to this breakdown, there are two types of seasonal 
methods: additive and multiplicative. Additive seasonality has a 
steady pattern amplitude, and multiplicative seasonality has the 
pattern amplitude increasing or decreasing over time. 

Figure 3.9  Different seasonal curves

You can use a scatter plot of your data (using either Excel or the 
View Data button on the Input Data tab) to decide whether you 
have trend or seasonal data. This can help you decide which 
methods will work best when forecasting the data. However, 
selecting all the time-series forecasting methods does not 
significantly slow down the calculations unless you are 
forecasting thousands of values at once, so you might as well try 
them all!

To select the forecasting methods to use:

1. In the Data Attributes tab, click on Next.

The Method Gallery tab appears.

2. In the Method Gallery tab, either:

� Try all the methods by clicking on Select All

� Try only some methods by clicking on Clear All and then 
clicking in the checkbox for each method you want to try
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3. To manually set the parameters for any method, overriding 

the automatic calculation of parameters:

a. Double-click in the method area.

The method�s parameter dialog appears.

b. Select the User Defined option.

The parameter fields become active. You can reset the 
method to automatically optimize the parameters at any 
time by selecting the Automatic option. 

c. Enter the parameter values in the parameter fields.

For more information on these parameters, see �Seasonal 
smoothing parameters� on page 48.

d. Click on OK.

The parameters dialog closes.

CB Predictor Note:  The user-defined settings remain until you reset 
them. A double asterisk next to the method in the Method Gallery indicates 
that the method is set to use user-defined parameters.

4. Set advanced options.

For more information on setting advanced options, see 
�Selecting error measures� and �Selecting forecasting 
techniques� below.

Selecting error measures

CB Predictor uses one of three error measures to determine 
which time-series forecasting method works best:

RMSE Root Mean Squared Error

MAD Mean Absolute Deviation

MAPE Mean Absolute Percentage Error

When determining the best method, CB Predictor calculates the 
selected error measure when fitting each method to the 
historical data. The method with the lowest error measure is 
considered best, and the rest of the methods are ranked 
accordingly. For more information on these error measures, see 
�Time-series forecasting error measures� on page 49.

By default, CB Predictor uses RMSE to select the best method.
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To change which error measure CB Predictor uses:

1. In the Method Gallery, click on Advanced.

The Advanced Options dialog appears.

2. Select the error measure you want CB Predictor to use to 
determine the best method.

For more information on the Advanced Options dialog, see 
�Advanced Options dialog� on page 95.

3. Click on OK.

The Method Gallery reappears.

Selecting forecasting techniques

CB Predictor uses one of four forecasting techniques for time-
series forecasting. 

Technique Optimizes the forecasting parameters to 
minimize the error measure using the technique:

Standard Forecasting
Error measure between the fit values and 
the historical data for the same period.

Simple Lead Error measure between the historical data 
and the fit offset by a specified number of 
periods (lead).

Weighted Lead Average error measure between the 
historical data and the fit offset by 0, 1, 2, 
etc. periods, up to the specified number of 
periods (weighted lead).

Holdout Error measure between a set of excluded 
data and the forecasting values. CB 
Predictor does not use the excluded data to 
calculate the forecasting parameters.

By default, CB Predictor uses standard forecasting to select the 
best method.

To change which forecasting technique CB Predictor uses:

1. In the Method Gallery, click on Advanced.

The Advanced Options dialog appears.
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2. Select the forecasting technique you want CB Predictor to 

use for time-series forecasting.

For more information on the Advanced Options dialog, see 
�Advanced Options dialog� on page 95.

3. If you selected Simple Lead, Weighted Lead, or Holdout, 
enter the appropriate lead or holdout in the field by the 
option.

4. Click on OK.

The Method Gallery reappears.

Method Gallery tab

The Method Gallery tab lets you select any combination of the 
time-series forecasting methods to try when forecasting your 
data. Selecting extra methods doesn�t significantly increase your 
forecast time unless you have thousands of data values.

Figure 3.10  Method Gallery tab
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Each method area has:

title The title of the method. For more 
information on each method, see �Selecting 
time-series forecasting methods� on page 
87 or Chapter 2, �Understanding the 
Terminology.�

check box Lets you select to try that method. You can 
select anywhere between one and all of the 
methods.

sample graph Shows what sample data and fitted data 
might look like for each method. 

In addition to this, double-clicking on each time-series method 
area opens that method�s parameters dialog. The parameters 
dialog lets you view a description and a sample graph of each 
method and manually set the parameters for that method. You 
do not need to set the parameters for the time-series forecasting 
methods. CB Predictor automatically finds the optimal 
parameters, unless you override this optimization by selecting 
to use User Defined parameters in this dialog. For more 
information on this dialog, see �Parameters dialogs� on page 
93.

The other buttons and options for this tab are:

Select All Selects all the time-series forecasting 
methods. 

Clear All Clears all the method checkboxes.

Advanced Opens the Advanced dialog, which lets you 
select the error measure to determine which 
method best fits the historical data. For 
more information, see �Advanced Options 
dialog� on page 95.
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Parameters dialogs

The parameters dialogs all have the same format. 

Figure 3.11  Parameters dialog for the Seasonal, Additive 
Smoothing method

They all include the following fields and options:

title The full title of method. Some titles on the 
Method Gallery dialog are abbreviated. 

Application Describes what kind of data the method 
works best for.

Forecast Describes what the resulting forecast looks 
like.

Method Describes how the method calculates its 
forecast.

chart Shows an example of fitted data with sample 
data. 

Automatic Sets CB Predictor to automatically optimize 
the values for the method�s parameters. 
This is the default.

User Defined Lets you enter values in the parameter 
fields. See Appendix A, �Time-series 
Forecasting Method Formulas� for more 
information on these parameters.
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CB Predictor Note:  CB Predictor will use these user-defined values on 
all forecasts until you select Automatic again. A double asterisk appears 
next to the name in the Method Gallery for all methods using user-defined 
parameters.

Periods Sets the number of periods that the method 
uses. You can only type in this field is you 
select User Defined.

The default is 3 for single moving average 
and 6 for double moving average. This 
parameter is only available for these 
methods.

Alpha Sets the Alpha parameter for the method, if 
applicable. You can only type in this field if 
you select User Defined.

This parameter is not available for the single 
moving average or double moving average 
methods.

Beta Sets the Beta parameter for the method, if 
applicable. You can only type in this field if 
you select User Defined.

This parameter is only available for the 
double exponential smoothing, Holt-
Winters� additive and Holt-Winters� 
multiplicative methods.

Gamma Sets the Gamma parameter for the method, 
if applicable. You can only type in this field 
if you select User Defined.

This parameter is only available for the 
seasonal methods.
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Advanced Options dialog

The Advanced Options dialog lets you select which error 
measure to use to determine which forecasting method best fits 
your data, and which forecasting technique to use to perform 
time-series forecasting. 

Figure 3.12  Advanced Options dialog

The options on this dialog are:

RMSE Selects root mean squared error as the 
statistic that determines the best forecast.

This is the default error measure. For more 
information, see �RMSE� on page 50 and 
Appendix B.

MAD Selects mean absolute deviation as the 
statistic that determines the best forecast.

For more information, see �MAD� on page 
50 and Appendix B.
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MAPE Selects mean absolute percent error as the 
statistic that determines the best forecast.

For more information, see �MAPE� on page 
50 and Appendix B.

Standard Forecasting
Selects to use the standard forecasting 
technique for time-series forecasting. This 
is the default forecasting technique.

For more information, see �Time-series 
forecasting techniques� on page 50.

Simple Lead Selects to use simple lead forecasting for 
performing time-series forecasting. If you 
select this technique, enter the number of 
lead periods you want to use in the adjacent 
field. 

The default number of lead periods is 1.

For more information, see �Simple lead 
forecasting� on page 51.

Weighted Lead Selects to use weighted lead forecasting for 
performing time-series forecasting. If you 
select this technique, enter the number of 
weighted lead periods you want to use in the 
adjacent field. 

The default number of weighted lead 
periods is 1. 

For more information, see �Weighted lead 
forecasting� on page 52.

Holdout Selects to use the holdout technique for 
time-series forecasting. If you select this 
technique, enter the number of periods you 
want to exclude from the forecast. 

The default number of periods to hold out 
is 1.

For more information, see �Holdout� on 
page 52.
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Entering the number of periods to forecast

After CB Predictor finds the method that best fits the historical 
data, it is ready to use that same method to forecast future 
values. You need to decide how many time periods you want to 
forecast.

As you are trying to decide, there are a few points to keep in 
mind:

� The first few values are fairly reliable. Only forecast as many 
values as you need.

� The farther out you try to forecast, the less reliable the 
forecasted values are. The confidence interval of any forecast 
grows to reflect this decrease in reliability.

To enter the number of periods to forecast:

1. In the Method Gallery, click on Next.

The Results tab appears.

2. Under Step 7, enter the number of periods you want to 
forecast.

Selecting a confidence interval
The confidence interval defines the range above and below a 
forecasted value where the value has some probability of 
occurring. For example, a confidence interval of 10% and 90% 
will give two points for each forecasted value. The lower point 
represents the 10th percentile. The higher point represents the 
90th percentile. The farther out the forecast is, the larger this 
range is.

To set a confidence interval, under Step 8, select the confidence 
interval you want to calculate and display with your results. 
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Select your results
After you identify your historical data, select the methods to try, 
and decide how many time periods you want to forecast, you 
must decide which results you want to create. CB Predictor can:

� Paste the forecasted data anywhere on your worksheet or into 
a new worksheet

� Create a chart that can show historical data, fitted values, and 
forecasted data and its confidence interval

� Generate a report summarizing the findings

� Create a PivotTable of all the historical data, fitted values, 
forecasted data, and confidence intervals

� Create a PivotTable of some or all the method information 
for each forecast, including the errors, parameters, and 
statistics for each method tried

You can choose to only generate basic results, such as pasted 
data and charts, until you are sure you have the forecasts you 
want. Then you can create customized, detailed reports and 
tables to present to others.

To generate the results you want:

1. Under Step 9, to paste forecasted values:

a. Select the Paste Forecasts option.

Enter the cell reference of the starting location in the 
field to the right. The default starting location pastes the 
forecasted values immediately at the end of your 
historical data.

b. To paste the data somewhere other than the end of the 
data, enter the cell where you want the pasted data to 
start or click on Select to select a different cell 
interactively.

c. Select to paste the forecasted values in rows or columns.

2. Select the other types of output you want by clicking on the 
appropriate checkboxes.
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3. To customize the output types:

a. Click on Preferences.

The Preferences dialog appears.

b. Click on the tab of the result you want to customize.

c. Change the options.

For more information on these options, see �Preferences 
dialog� on page 102.

d. Repeat steps b and c for any other result you want to 
customize.

e. Click on OK.

The Results tab of the wizard reappears.

4. Enter a title in the Title field to identify your output.

This title appears on all the result sheets that CB Predictor 
creates. The default title is the worksheet name.

Results tab

Results tab lets you select what kind of output you want CB 
Predictor to generate for you. 

Figure 3.13  Results tab of the wizard dialog
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The options, fields, and buttons of this tab are:

Number Of Periods To Forecast
Lets you enter the number of time periods 
you want CB Predictor to forecast for each 
series. You can enter any integer from 1 to 
100, but do not use a value larger than the 
number of historical data points.

The default is 4.

Confidence Interval
Lets you select the probabilities of the 
confidence interval from a list of typical 
ones.

The default is 5% and 95%.

Paste Forecasts Selects to add the forecasted values to the 
end of the historical data range on your 
original spreadsheet or somewhere else in 
your workbook. 

By default, this is on, set to paste points at 
the end of your historical data. To select a 
different cell range than the one in the Paste 
field, click on Select to change the location 
and select to paste the data either in rows or 
columns.

Select Brings up a small Select Range dialog to let 
you select the cells directly from the 
spreadsheet. After selecting the cells, click 
on OK to return to the Results tab.

Rows/Columns Defines whether you want your data pasted 
in rows or columns.

Report Creates a customizable, detailed report that 
can include elements such as a summary for 
each forecasted variable, which method was 
best, what parameters the method used, and 
the error.

This is off by default.
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Chart Creates a chart for each data series to 

forecast. Each chart shows, optionally, the 
historical data, fitted values, forecasted 
values, and a confidence interval.

You can only put 40 CB Predictor charts on 
a workbook. If you need more than 40 
charts, CB Predictor creates new workbooks 
when necessary.

This is off by default.

Results Table Creates a customizable PivotTable that lists 
items such as all the forecasted and fitted 
values, as well as the values defining the 
confidence interval.

This is off by default.

Methods Table Create a customizable PivotTable that lists 
items such as each method tried for each 
variable, as well as all the errors, 
parameters, and statistics for each method.

This is off by default.

Preferences Lets you set the different results� options, 
such as whether to prompt you when 
pasting will overwrite data or whether to 
include charts on your reports. This button 
opens the Preferences dialog, with tabs for 
each different result.

For more information, see �Preferences 
dialog� below.

Title Lets you enter a title that will appear for 
most results.

The default is the worksheet name.
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Preferences dialog

The Preferences dialog lets you set options about how your 
selected results appear. 

Figure 3.14  Preferences dialog

There are tabs for each type of result:

� Paste

� Report

� Chart

� Results Table

� Methods Table

CB Predictor Note:  You can change results options for unselected result 
options. You still do not generate a type of result unless you select it in the 
Results tab of the wizard dialog.
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Paste

The options for the Paste Forecasts result are on the Preferences 
dialog under the Paste tab.

Figure 3.15  Preferences dialog - Paste tab

You can change these options even if Paste Forecasts is not a 
selected result. CB Predictor saves the settings and applies them 
the next time you use the Paste Forecasts result. 

The options in this tab are:

Warn When Pasting Will Overwrite Other Data
Displays a warning when your pasted data 
will overwrite existing data on your 
spreadsheet.

This is on by default.
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Paste Forecasts As Crystal Ball Assumptions
Creates pasted cells as Crystal Ball 
assumptions. The defined assumptions are 
Normal distributions with a mean that is the 
forecasted value and a standard deviation 
that is based on the RMSE of the fitted data.

CB Predictor Note:  CB Predictor does not create assumptions if the 
variation in the data is zero or approaches infinity.

This is on by default.

Style Of Pasted Results
Sets how the pasted data appears on your 
spreadsheet. This helps you identify the 
forecasted data from your historical data.

You can set the forecasted data to be bold or 
italics or both. 

The default is only bold.

Report

The options for the Report result are on the Preferences dialog 
under the Report tab.

Figure 3.16  Preferences dialog - Report tab
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You can change these options even if Report is not a selected 
result. CB Predictor saves the settings and applies them the next 
time you use the Report result. 

The options in this tab are:

Summary Includes a summary section at the top of the 
report.

The report includes a summary by default.

Autocorrelations
Includes the autocorrelation coefficients for 
the top 18 autocorrelations for each data 
series. 

The report does not include autocorrelation 
by default.

Chart Includes charts in the report. You can also 
set your chart options differently than your 
regular chart options. For more information 
on the chart options, see �Chart� on page 
106.

The report includes charts by default.

Stats Includes the series statistics (e.g., mean, 
standard deviation) and, if the series is a 
dependent variable, the regression statistics 
(e.g., R-squared, Durbin-Watson).

The report includes statistics by default.

Forecast Values Includes the actual forecasted values.

The report includes forecasted values by 
default. 

Confidence Interval
Includes the points that define the 
confidence interval.

The report includes confidence interval 
points by default. If you selected None for 
the confidence interval on the Results tab, 
no confidence interval appears in the 
report.
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Methods Displays information about the methods CB 
Predictor tried for each series. You can 
display information for all the methods 
tried, or just for the top 1, 2, or 3 methods. 
For each method, you can select to display 
the errors, statistics, parameters, or any 
combination.

By default, the report includes all the 
information about all the methods.

Location Indicates whether the report should appear 
in a new worksheet of the current workbook 
or in a new workbook.

If you select to place reports in the current 
workbook, you can also indicate whether 
you want CB Predictor to create a new 
worksheet every time you run your forecast 
or to replace the report on the worksheet 
when you rerun your forecast.

The default is Current Workbook with 
Insert Sheet.

Chart

The options for the Chart result are on the Preferences dialog 
under the Chart tab.

Figure 3.17  Preferences dialog - Chart tab
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You can change these options even if Chart is not a selected 
result. CB Predictor saves the settings and applies them the next 
time you use the Chart result. 

The options in this tab are:

Chart Items Selects which types of data appear on the 
charts. You can select from: Historical Data, 
Fitted Results, Forecast Values, and 
Confidence Interval.

By default, all the items appear on the 
charts.

Chart Size Scales the generated charts to a percentage 
of the normal size. You can enter the 
percentage as an integer between 20 and 
400.

This is 100%, by default.

Location Indicates whether the charts should appear 
in a new worksheet of the current workbook 
or in a new workbook.

If you select to place the charts in the 
current workbook, you can also indicate 
whether you want CB Predictor to create a 
new worksheet every time you run your 
forecast or to replace the charts on the 
worksheet when you rerun your forecast.

The default is Current Workbook with 
Insert Sheet.
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Results Table

The options for the results table result are on the Preferences 
dialog under the Results Table tab.

Figure 3.18  Preferences dialog - Results Table tab

You can change these options even if results table is not a 
selected result. CB Predictor saves the settings and applies them 
the next time you use the Results Table result. 
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The options in this tab are:

Table Items Selects which items to include in the Results 
table. You can include any combination of: 
Historical Data, Fitted Results, Forecast 
Values, Confidence Interval or Residuals.

The default is to include all the items.

Location Indicates whether the PivotTable should 
appear in a new worksheet of the current 
workbook or in a new workbook.

If you select to place the results table in the 
current workbook, you can also indicate 
whether you want CB Predictor to create a 
new worksheet every time you run your 
forecast or to replace the results table on the 
worksheet when you rerun your forecast.

The default is Current Workbook with 
Insert Sheet.

Methods Table

The options for the Methods Table result are on the Preferences 
dialog under the Methods Table tab.

Figure 3.19  Preferences dialog - Methods Table tab
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You can change these options even if Methods Table is not a 
selected result. CB Predictor saves the settings and applies them 
the next time you use the Methods table result. 

The options in this tab are:

Table Items Selects which items to include in the 
Methods table. You can include information 
on all the forecasting methods that CB 
Predictor tried, or just the top 1, 2, or 3 
methods. 

For each method, you can include any 
combination of: Errors, Statistics, 
Parameters, and Ranking.

The default is to include all the information 
for all the forecasting methods.

Location Indicates whether the PivotTable should 
appear in a new worksheet of the current 
workbook or in a new workbook.

If you select to place the generated methods 
table in the current workbook, you can also 
indicate whether you want CB Predictor to 
create a new worksheet every time you run 
your forecast or to replace the methods 
table on the worksheet when you rerun your 
forecast.

The default is Current Workbook with 
Insert Sheet.

Previewing and running the forecast
CB Predictor actually calculates the forecasts for each data series 
when you select either Preview or Run. The difference is that 
Preview lets you view the forecasts and make changes before it 
generates any of the results. Run simply generates the results.

1. To preview the forecast before generating the selected 
results, click on Preview.

The Preview dialog appears. For more information, see 
�Preview Forecast dialog� on page 111.

2. To run the forecast and produce the selected results, click 
on Run.
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CB Predictor Note:  You can click on Preview or Run from any of the 
wizard tabs at any time, as long as the data has been properly defined in 
the Input Data tab.

Preview Forecast dialog

You can open the Preview dialog from the wizard at any time 
after you define valid input data. To generate values for the 
Preview dialog, CB Predictor actually calculates the forecast for 
each series using each of the methods selected in the Method 
Gallery tab of the wizard. These results appear in the Preview 
chart.

Figure 3.20  Preview dialog

The Preview Forecast chart displays the historical, fitted, forecast, 
and confidence interval data values for each method and for each 
data series. To the right of the chart, it also displays the error 
measure and the parameters (as applicable) for the selected series 
and method.
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In addition to previewing your data, the preview dialog lets you 
override the method that CB Predictor found to forecast best. 
When you click on Run in the forecast wizard, CB Predictor 
outputs results to a new or current worksheet. The results are for 
the method that best fits your historical data. If, after viewing 
the forecast from the different methods, you decide to use the 
results of another method, you can override this best method. 
CB Predictor then outputs the results using this new best 
method.

The fields, options, and buttons in this dialog are:

Series Lists all the data series in your spreadsheet. 
The selected series appears in the chart.

Method Lists all the data methods from best to worst 
that CB Predictor tried when forecasting the 
selected series from the Series field. The 
selected method is used to forecast the 
selected series (from the Series field) in the 
chart.

If you indicated on the Data Attributes tab 
that your data had no seasonality, CB 
Predictor skips the seasonal methods, and 
they do not appear in this list, even if you 
selected them in the Method Gallery.

Override Best Lets you reassign a new method to be the 
�best.� The new best method appears in the 
list as the best. The best method (that the 
program chose or that you overrode) is used 
for all output results.

Use this button to override the best method 
if your visual inspection tells you that 
another method is better. For example, 
sometimes CB Predictor selects a moving 
average method for seasonal data because it 
fits the historical data closely, even though it 
wouldn�t predict future values the best.

chart Displays all the values graphically for the 
items selected in the Chart Items area.

Chart Items Selects the items to display in the chart. The 
choices are: Historical, Fitted, Forecast, and 
Confidence.
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errors and parameters

Displays the error (using the error measure 
in the Advanced dialog) for the current 
series and method. If the method has 
associated parameters, they appear below 
the error.

Zoom In Increases the magnification of the data 
graph, showing less data points.

Zoom Out Decreases the magnification of the data 
graph, showing more data points.

Analyzing the results
CB Predictor makes the actual forecasting process pretty simple, 
but you still must understand the results it gives you. 

Pasted forecasts
Two options in the Results tab affect pasted data: the Paste 
Forecasts option and the number of periods to forecast. If you 
selected Paste Forecasts, when you click on Run, CB Predictor 
pastes the number of forecasted values to the end of your 
historical data or somewhere else, if you specify another 
location. The worksheet automatically scrolls to where the 
pasted data begins.

The forecasted values can appear in bold or italics, depending 
on the selected options in the Paste Preferences dialog.

Even through CB Predictor tried all the methods you selected in 
the Method Gallery, it generates the pasted values using the best 
method, unless you overrode the best method. In that case, the 
program generates the pasted values using the overriding 
method.

Statistical Note:  Of the eight time-series forecasting methods, two result 
in flat lines: single moving average and single exponential smoothing. 
The forecasted values for these are all the same. This is not an error. It is 
the best possible forecast for volatile or patternless data.
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When you paste regression results, the independent variable 
forecast values are pasted as simple value cells. The dependent 
variable forecasted values are created as formula cells with the 
regression equation as the formula. The regression equation 
coefficients appear below the pasted values.

If you did not generate any charts with your results, you can 
create an Excel chart by selecting the forecasted values (along 
with some historical data) and using Excel�s Chart wizard.

Charts
Three options in the Results tab affect charts:

Number Of Periods To Forecast
Sets how many forecasted values appear on 
the chart.

Confidence Interval
Sets which confidence interval to calculate. 
If you select None, you cannot display a 
confidence interval on your charts.

Chart option Selects whether to generate charts.

If you select Chart and click on Run, CB Predictor generates 
Excel charts for each series with the number of forecasted 
values. The charts appear on either a different worksheet of the 
current workbook or a different workbook, depending on the 
selected options in the Chart Preferences dialog. The data used 
to generate the charts appears to the right of the charts. 

Even though CB Predictor tried all the methods you selected in 
the Method Gallery, it generated the chart values using the best 
method, unless you overrode the best method. In that case, the 
program generated the chart values using the overriding 
method.

On the chart, the green line represents your historical data, the 
blue lines represent both the fitted and forecasted values, and 
the red lines above and below the forecasted values represent 
the upper and lower confidence interval. There is a gap between 
where the historical and fitted values end and the forecasted 
values begin to delineate the past and future values.
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Statistical Note:  Of the eight time-series forecasting methods, four result 
in straight lines: single moving average, single exponential smoothing, 
double moving average, and Holt�s double exponential smoothing. Only 
the seasonal methods and multiple linear regression result in curves that 
try to approximate any repeated data pattern.

Excel Note:  You can print your charts in black and white from Excel by 
selecting File > Page Setup > Sheet > Black And White.

Reports
Four options in the Results tab affect reports:

Number Of Periods To Forecast
Sets how many forecasted points appear in 
the report.

Confidence Interval
Sets which confidence interval to calculate. 
If you select None, you cannot display a 
confidence interval on your report.

Title Specifies the title that appears at the top of 
the report.

Report option Selects whether to generate a report.

If you selected Report, and you clicked on Run, CB Predictor 
generated one report for your entire forecast. The report 
appears on either a different worksheet of the current workbook 
or a different workbook, depending on the selected options in 
the Report Preferences dialog.

Unlike the pasted data and charts, the report can have 
information about one or all of the methods selected in the 
Method Gallery. For example, if you selected to include the 
forecasted values and charts, CB Predictor created those using 
the best method. You can include statistics and parameters, 
however, for each method tried.

Excel Note:  You can print your report in black and white from Excel by 
selecting File > Page Setup > Sheet > Black And White.
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Results table
Three options in the Results tab affect the Results table:

Number Of Periods To Forecast
Sets how many forecasted values appear for 
each method on the Results table.

Confidence Interval
Sets which confidence interval to calculate. 
If you select None, you cannot display a 
confidence interval on your Results table.

Results Table option
Selects whether to generate a Results table.

If you selected Results table, and you clicked on Run, CB 
Predictor generated one Results table for all the series. The 
Results table appears on either a different worksheet or a 
different workbook, depending on the selected options in the 
Results Table Preferences dialog. 

Even through CB Predictor tried all the methods you selected in 
the Method Gallery, it generates the Results table using the best 
method, unless you overrode the best method. In that case, the 
program generates the result values using the overriding 
method.

Methods table
Only one option in the Results tab affects the Methods table: the 
Methods table option, which selects whether to generate it.

If you selected Methods table, and you clicked on Run, CB 
Predictor generated one Methods table for your entire forecast. 
The Methods table appears on either a different worksheet or a 
different workbook, depending on the selected options in the 
Methods Table Preferences dialog. 

The Methods table reports all the parameters and statistics for 
one or all the methods you selected in the Method Gallery. In 
the table, the methods appear in the order from the Method 
Gallery. The method used to generate the forecasted values, 
either the best method or the overriding method, is highlighted 
in bold, blue text. The method is likely to be different for each 
forecasted series.
116 CB Predictor User Manual 



1

To compare the quality of the results of different time-series 
forecasting methods, check out the errors: RMSE, MAD, and 
MAPE. For all of these, the smaller the better. So you can 
compare the RMSE of one method to the RMSE of another 
method, and the smaller one should be ranked better. However, 
you cannot compare the RMSE of one method to the MAD or 
MAPE of another method. For more information, see �Time-
series forecasting error measures� on page 49.

To compare the quality of a regression, look for the following 
values:

For more information on these statistics, see �Regression 
statistics� on page 161.

Statistic Range Ideal value Shows that:

R2 or Adjusted 
R2

0 to 1 Close to 1 The linear regression accounts for 
almost all the variability in the 
dependent data.

F probability 0 to 1 Less than 
0.05

The quality of the overall regression 
(dependency of the dependent 
variable on the independent 
variables) is good.

t probability 0 to 1 Less than 
0.05

The quality of the coefficient of the 
regression equation is good.

Durbin-Watson 0 to 4 2 No auto-correlation (at lag 1) exists.

Theil�s U Greater 
than 0

Less than 1 The quality of the results is better 
than guessing.
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Customizing reports and charts
You can customize reports and charts by customizing the Excel 
templates that control how they look. The CB Predictor folder 
contains these two template files Report and Charts.

To customize reports or charts:

1. In the CB Predictor folder, open the appropriate template 
file.

2. Make any style changes you want.

For example, in the report, you can change the font of the 
title, the width of the columns, or turn on grid lines. For the 
chart, you can change the chart type or the color of the upper 
confidence interval and fitted lines, change the background 
color, or change the angle of the horizontal axis labels.

3. Save and close the template file.

The next time CB Predictor generates a report or chart, it will 
use the modified template and appear with the new style. 

Figure 3.21  Chart as a 3D ribbon chart
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In this chapter
� Monica�s Bakery example

� Forecasting time-series data

� Forecasting regression data

This chapter describes a detailed Excel 
model for Monica�s Bakery. The workbook 
has worksheets for sales data, operations, 
and cash flow. The Sales Data worksheet 
contains all the historical sales data that is 
available for forecasting. The Operations 
worksheet calculates the amount of 
different ingredients required to make 
different quantities of the three different 
breads. The Cash Flow worksheet calculates 
how much money the bakery has to spend 
on various capital projects. The Labor 
Costs worksheet estimates the increase in 
hourly wages to decide whether to invest in 
labor-saving equipment.

This chapter explains how to use this type 
of information to appropriately stock bread 
ingredients, plan for major purchases such 
as constructing a silo or buying a delivery 
van, and estimate the value of the business.
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Overview

Monica�s Bakery is a rapidly growing bakery in Albuquerque, 
New Mexico. It opened in March of 1996, and Monica has kept 
careful records (in an Excel workbook) of the sales of her three 
main products: French bread, Italian bread, and pizza. With 
these records, she can better predict her sales, control her 
inventory, market her products, and make strategic, long-term 
decisions. To see Monica�s workbook, in the CB Predictor 
Examples folder, open Bakery.xls.

These numbers are ready to forecast. The following examples 
track Monica's decision-making processes as she works through 
both short-term and long-term decisions.

Inventory control
The initial reason that Monica needs to forecast is to maintain 
enough ingredients to keep up with her production. Monica's 
Bakery places regular orders for ingredients, and Monica�s 
distributors give her discounts for buying in bulk. However, she 
must balance this savings with the freshness of her products, 
which requires using the freshest ingredients possible. 

In the past Monica scheduled deliveries to her business of 
bagged flour and other ingredients whenever �it looked low.� 
Sometimes this required paying for express delivery when 
demand was high or, when the demand after placing the order 
was unexpectedly low, letting ingredients sit unused until they 
were no longer fresh. With better forecasting, Monica wants to 
place orders that give her the best buying power while 
maintaining the quality of her products.
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The Sales Data worksheet shows the daily sales data of each of 
these products from the opening until the end of June, 1998.

Figure 4.1  Bakery Sales Data worksheet

Monica created a PivotTable in Excel that summarized the data 
for her three main products by week at the bottom of the 
Operations worksheet. By creating a PivotTable from the data, 
Monica can change the table to summarize her results by 
product, by time period, etc.
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Figure 4.2  Bakery Operations worksheet

Monica wants to order monthly, one month in advance. The 
bakery has already received this month�s delivery, which she 
placed last month. This month, she must place the order that 
will be delivered at the end of this month for the next month. So 
she must forecast sales for the next two months. Since she is in 
week 173 of her business, the forecast will be for weeks 174 to 
181. 

To forecast the sales for weeks 174 to 181:

1. In the Bakery.xls workbook, click on the Operations tab.

The Operations worksheet appears.

2. Select one cell in the Historical Demand By Week 
PivotTable at the bottom of the worksheet.

3. Start CB Predictor.

CB Predictor�s Intelligent Input automatically selects all the 
PivotTable data.
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4. Make sure:

� The cell range is selected correctly, with headers, dates, 
and data in columns (Steps 1 and 2)

� The time periods are in weeks with a seasonality of 52 
weeks (Step 4)

� Multiple Linear Regression is off (Step 5)

� All time-series methods are selected (Step 6)

� The number of periods to forecast is 8 (Step 7)

� The only result selected is Paste Forecasts at the bottom 
of the PivotTable (Step 9)

5. Click on Run.

The results paste to the end of the PivotTable.

6. Exit the Bakery.xls workbook without saving your changes.

CB Predictor Note:  If you save your changes, you will overwrite the 
example spreadsheet.

The last four weeks of forecast values for each data series are 
automatically summed and placed into the table at the top of the 
spreadsheet, in the Sales Forecast column (cells C11:C13). In 
this table, the monthly sales forecast is converted in the number 
of items sold and then into the weight of each product.

The second table (below this top table) takes the total weight of 
each product (in cells C17, C21, C25) and calculates how much 
of each ingredient is required to produce that much product. 
The ingredients for each are then totalled in the third table 
(below the second table) into the total amounts to order for the 
month (cells D33 to D36).

So Monica should order:

� 79,253 pounds of flour

� 253 pounds of yeast

� 358 pounds of salt

� 12 pounds of cheese
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Company finances

Monica is always concerned about the bakery�s month-to-month 
cash flow (on a percent of sales basis). Not only can CB Predictor 
help her manage her inventory, she can use it to predict her 
revenue and understand her cash flow situation better. 
Understanding the bakery�s cash flow can, in turn, help her time 
major capital expenditures better. 

There are two major capital expenditures Monica is considering 
for the bakery: a flour silo and a delivery van. She wants to start 
construction on the silo in July and purchase the new delivery 
van in September. She needs to forecast when the bakery will be 
able to safely pay for these projects or whether the bakery must 
finance them.

The bakery cash flow information is laid out on the Cash Flow 
worksheet.

Figure 4.3  Bakery Cash Flow worksheet

This worksheet has a PivotTable at the bottom that summarizes 
the sales data for the bakery�s three main products by month. 
You can forecast the next three months of revenue to decide 
when to attempt the capital expenditures.
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To forecast the next three months of revenue:

1. In the Bakery.xls workbook, click on the Cash Flow tab.

The Cash Flow worksheet appears.

2. Select one cell in the Historical Revenue By Month 
PivotTable at the bottom of the worksheet.

3. Start CB Predictor.

CB Predictor�s Intelligent Input automatically selects all the 
PivotTable data.

4. Make sure:

� The cell range is selected correctly, with data in rows and 
no dates or headers (Steps 1 and 2)

� The time periods are in months with a seasonality of 12 
months (Step 4)

� All time-series methods are selected (Step 6)

� The number of periods to forecast is 3 (Step 7)

� The only result selected is Paste Forecasts At Cell E6 
(Step 9)

� The pasted results are set to Paste In Rows

5. Click on Run.

The results paste into the table at the top of the worksheet 
(cells E6 to G6).

6. Exit the Bakery.xls workbook without saving your changes.

CB Predictor Note:  If you save your changes, you will overwrite the 
example spreadsheet.

The revenue forecasts for the next three months are used to 
calculate the percentage expenses in the second table.

The second table calculates the total expenses, and the third 
table calculates the necessary expenditure for each 
extraordinary item. Below these tables is the cash flow summary 
for the next three months, based on the forecasts. The net cash 
at the end of each month is what Monica is looking for.
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Figure 4.4  Monthly net cash flow results

Based on the forecast, the bakery might be better off waiting 
another month before they try to purchase the van.

Human resources
Monica's Bakery is a labor-intensive operation that pays a very 
competitive wage. However, to maintain her target profitability, 
Monica must control her labor costs. She knows there are many 
things done around the bakery that could be done by expensive 
machinery, such as kneading, mixing, and forming. By 
accurately predicting her labor costs, she can decide when to 
invest in some of this equipment to keep her total expenses 
within budget.

From her interest in economics, Monica knows that a few key 
macro-economic figures drive labor costs, such as the Industrial 
Production Index, local CPI, and local unemployment. All of 
these figures are available on the Internet on a monthly basis 
from the Bureau of Labor Statistics and the Department of 
Commerce.
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Monica has created her Labor Costs worksheet with a PivotTable 
at the bottom that lists her average hourly wage for each month 
and the monthly numbers for these three indicators. 

Figure 4.5  Bakery Labor Costs worksheet

The average hourly wage depends on or is affected by the other 
three variables. Because of the dependency, Monica decides to 
use regression instead of time-series forecasting. For regression, 
the dependent variable is Monica�s Average Wage, and the other 
three are the independent variables. 

To forecast the hourly wage using regression:

1. In the Bakery.xls workbook, click on the Labor Costs tab.

The Labor Costs worksheet appears.

2. Select one cell in the Economic Variable for Regression 
Analysis table at the top of the worksheet.

3. Start CB Predictor.

CB Predictor�s Intelligent Input automatically selects all the 
table data.
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4. Make sure:

� The cell range is selected correctly, with headers, dates, 
and data in columns (Steps 1 and 2)

� The time periods are in months with a seasonality of 12 
months (Step 4)

� Multiple Linear Regression is on (Step 5)

� The regression variables are defined: Monica�s Average 
Wage is a dependent variable, all the others are 
independent variables (Step 5)

� The regression method is set to Standard (Step 5)

� All time-series methods are selected (Step 6)

� The number of periods to forecast is 6 (Step 7)

� The only result selected is Paste Forecast (Step 9)

5. Click on Run.

The results paste at the bottom of the table (cells B53 to F58).

6. Exit the Bakery.xls workbook without saving your changes.

CB Predictor Note:  If you save your changes, you will overwrite the 
example spreadsheet.

CB Predictor's HyperCasting technology first generates a 
regression equation to define the relationship between the 
dependent and independent variables. Second, it uses the 
time-series forecasting methods to forecast the independent 
variables individually. Third, CB Predictor uses those forecasted 
values to calculate the dependent variable values using the 
regression equation.

The forecast cells of the independent variables are simple value 
cells. The forecast cells of the dependent variable are formula 
cells containing the regression equation and using the other 
values from the independent variables. 

The average wage in December is used to calculate the total 
increase in her payroll. The increase will only be 2%. With these 
results, Monica decides that labor costs will not increase enough 
over the next six months to justify a major equipment capital 
purchase.
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Using CB 
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In this chapter
� How to load CB Predictor and Crystal 

Ball at the same time

� How to create assumptions out of 
pasted values

� Running a simulation with CB 
Predictor assumptions

This chapter describes how to run Crystal 
Ball with CB Predictor to add risk analysis 
to your forecast.

It also gives a detailed example of a 
spreadsheet where you might want to use 
both forecasting and simulation.
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Using CB Predictor with Crystal Ball

�It is far better to foresee even with uncertainty than not to foresee at 
all.�

- Henri Poincaré
  in Foundations Of Science

If you are a sales manager, you might be asked to predict future 
sales to let the manufacturing organization to produce sufficient 
quantities of product to meet demand. However, as shown by the 
confidence interval around your forecasted data, there is usually 
a large degree of uncertainty associated with the true future 
values. How do you account for the uncertainty?

Well, if you have Decisioneering�s Crystal Ball along with CB 
Predictor, you can define the forecasted values as assumptions, 
create a Crystal Ball forecast that represents the entire range of 
possible outcomes for the forecasted sales, and run a simulation 
to analyze the effects of the uncertainty. Crystal Ball will 
generate a forecast chart showing the total amount of product 
that manufacturing must produce, to meet demand within a 
specific certainty. You can use the mean of the Crystal Ball 
forecast or perhaps give manufacturing a range and say that you 
are 90% certain that the actual number will fall in that range. 
This is the power that combining the two products gives you.

To use CB Predictor and Crystal Ball together, there are a few 
items you must understand:

� How to load CB Predictor and Crystal Ball simultaneously

� How to set CB Predictor to create Crystal Ball assumptions

Loading stand-alone CB Predictor and Crystal Ball
Both CB Predictor and Crystal Ball are Excel add-ins that you 
can load automatically with Excel or from their respective icons. 
However, loading either add-in program after Excel is running 
requires some work. 

Therefore, loading both add-ins simultaneously in the same 
instance of Excel can require some planning.

Glossary Term:
assumptions�
Estimated values in a 
spreadsheet model that 
Crystal Ball defines with a 
probability distribution.

Glossary Term:
Crystal Ball forecast�
A statistical summary of the 
assumptions in a 
spreadsheet model, output 
graphically or numerically.
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There are four different combinations possible:

� Both load automatically with Excel

� CB Predictor loads automatically, but Crystal Ball doesn�t 
load automatically

� Crystal Ball loads automatically, but CB Predictor doesn�t 
load automatically

� Neither CB Predictor nor Crystal Ball load automatically

Both load automatically
If both CB Predictor and Crystal Ball load automatically, then 
both will be available no matter how you start Excel. In this case, 
you can load the programs by starting:

� Excel using any method

� CB Predictor from its icon

� Crystal Ball from its icon

Only CB Predictor loads automatically
If you set up CB Predictor to load automatically when you start 
Excel, then you have one option: to load these programs using 
the Crystal Ball icon. This icon loads Crystal Ball and Excel, and 
when Excel loads, CB Predictor automatically loads as well.

Only Crystal Ball loads automatically
If you set up Crystal Ball to load automatically when you start 
Excel, then you have one option: to load these programs using 
the CB Predictor icon. This icon loads CB Predictor and Excel, 
and when Excel loads, Crystal Ball automatically loads as well.
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Neither loads automatically

If you have neither CB Predictor nor Crystal Ball loading 
automatically with Excel, you will need to perform several steps 
to load both simultaneously. Your first choice should be to set up 
one of the add-ins to load automatically using the procedure 
below. If you are unsure about which to load automatically, load 
CB Predictor to start automatically, since it loads quicker than 
Crystal Ball.

To set up either add-in to load automatically:

1. Start Excel.

2. Select Tools > Add-ins.

The Add-ins dialog appears.

3. If the add-in you want to start automatically appears in the 
add-ins list unchecked, select it.

Excel Note:  If it is already checked, the add-in already started with Excel.

4. If add-in doesn�t appear in the add-ins list:

a. Click on Browse.

b. Find your CB Predictor or Crystal Ball installation 
folder.

Excel Note:  The default installation folder is CB Predictor, installed by 
default under the Program Files folder. The default installation folder for 
Crystal Ball is Crystal Ball under Program Files (e.g., C:\Program 
Files\Crystal Ball).

c. Select the file cbpred.xla (for CB Predictor) or cb.xla 
(for Crystal Ball).

d. Click on OK.

The add-in appears checked in the add-ins list.

5. Click on OK.

The add-in starts, opening the appropriate toolbar.
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Automatically generating Crystal Ball assumptions
Integrating CB Predictor and Crystal Ball is as easy as setting an 
option that automatically generates forecasted values as Crystal 
Ball assumptions. To set this option:

1. On the Results tab, click on Preferences.

The Preferences dialog appears.

2. Select the Paste tab.

3. Select the Paste Forecasts As Crystal Ball Assumptions 
option.

4. Click on OK.

5. Make sure that you selected the Paste Forecasts At Cell 
result.

6. Run your forecast.

As long as you have Crystal Ball loaded, this option creates 
Crystal Ball assumptions as it pastes the forecasted values to 
your spreadsheet.

The pasted values have a style based on the Style Of Pasted 
Results options (bold, by default). The cell color and pattern 
changes to match the assumption cell preferences set in Crystal 
Ball under Cell > Cell Preferences (green, by default).

Time-series forecast method results
For data series forecasted using time-series methods, CB 
Predictor creates the assumptions as normal distributions with:

� A mean equal to the forecasted value in the cell

� For time-series forecasted data, a standard deviation 
calculated using the RMSE
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Multiple linear regression results

For multiple linear regression, CB Predictor creates assumptions 
for the independent variable forecast values only. This is 
because the independent variable values are simple value cells, 
but the dependent variable values are formula cells that are a 
function of the independent variables. 

If you want to see the variability of the dependent variable, you 
can select the pasted formula cells and define them as Crystal 
Ball forecast cells (by selecting Cell > Define Forecast). More 
likely, you might want to create one formula cell that represents 
the sum of the data in the dependent variable cells and define 
that formula cell as a Crystal Ball forecast.

Monica�s bakery example revisited
Monica decides to incorporate uncertainty into her cash flow 
analysis. For more information on this example, see �Company 
finances� on page 125.

She had already forecasted her revenue for the next few months, 
which indicated that she could start construction on her silo in 
July, but should probably wait to buy her delivery van in 
September. She has already committed to the silo construction. 
However, she realizes that her forecasts are point estimates, and 
wants to be at least 90% sure that she won�t run out of cash and 
be unable to meet payroll or other critical bills.

To get a picture of the uncertainty in the bakery�s cash flow:

1. Either:

� If you have stand-alone CB Predictor, load both Crystal 
Ball and CB Predictor in the same running instance of 
Excel.

For more information on loading both programs at once, 
see �Loading stand-alone CB Predictor and Crystal Ball� 
on page 133.

� For CB Predictor as part of Crystal Ball 2000, 
Professional Edition, start Crystal Ball.

2. Select Run > Run Preferences.

The Crystal Ball Run Preferences dialog appears.
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3. Set the following options:

� Run 500 trials

� Use Latin Hypercube

� Use an initial seed value of 999

� Use a sample size of 500

4. Click on OK.

5. From the CB Predictor\Examples folder, open the 
Bakery.xls workbook.

You can also find this example by selecting Start > Programs 
> CB Predictor > CB Predictor Examples.

6. Click on the Cash Flow tab.

The Cash Flow worksheet appears.

7. Select one cell in the Historical Revenue By Month 
PivotTable at the bottom of the worksheet.

8. Start CB Predictor.

CB Predictor�s Intelligent Input automatically selects all the 
PivotTable data.

9. Make sure:

� The cell range is selected correctly, data in rows, and no 
dates or headers (Steps 1 and 2)

� The time periods are in months with a seasonality of 12 
months (Step 4)

� Turn off regression (Step 5)

� All time-series methods are selected (Step 6)

� The number of periods to forecast is 3 (Step 7)

� The only result selected is Paste Forecast at $AQ$38 (Step 
9)

� In the Preferences dialog, under the Paste tab, the Paste 
Forecasts As Crystal Ball Assumptions option is checked 
(Step 9)
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10. Click on Run.

The results paste at the bottom of the PivotTable as Crystal 
Ball assumptions, and the values also appear in the table at 
the top of the worksheet (cells E6 to G6).

11. Define cells E29:G29 as forecasts for Month 1, Month 2, and 
Month 3, respectively, by selecting each cell and selecting 
Cell > Define Forecast.

12. Run a simulation of 500 trials. 

For more information on running a Crystal Ball simulation, 
see your Crystal Ball User Manual.

Monica can now look at the net cash left at the end of each 
month as a forecast. 

Figure 5.1  Monthly net cash flow results
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To be certain that the bakery will not drop below the cash reserve 
at the end of any month, she slides the left certainty grabber to 
20,000. 

Based on the probability of dropping below the reserve 
threshold, she decides to delay buying the van until September.
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In this appendix

This appendix provides formulas for the 
following time-series forecasting methods.

� Single exponential smoothing

� Double exponential smoothing

� Seasonal additive smoothing

� Seasonal multiplicative smoothing

� Holt-Winters� additive seasonal 
smoothing

� Holt-Winters� multiplicative seasonal 
smoothing
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Nonseasonal forecasting method formulas

Below are the formulas of the nonseasonal time-series 
forecasting methods.

CB Predictor Note:  This appendix does not list the formula for single 
moving average because of its simple nature.

Double moving average
The formula CB Predictor uses for the double moving average 
method is:

2*S[1](t) - S[2](t) + (S[1](t) - S[2](t))

where S[1](t) represents the moving average (with period p) of 
the historical data, S[2](t) represents the moving average of the 
S[1](t) series (with period p), and p represents the number of 
time periods the moving averages are over.

Single exponential smoothing
The formula CB Predictor uses for the single exponential 
smoothing method is:

S[1](t) = α * y(t) + (1 - α) * S[1](t - 1)

where S[1](t) represents the single exponential smoothing 
�smoothed estimate� for time period t, y(t) is the historical data 
value at time t, and α is the smoothing constant between 0 and 1.

Holt�s double exponential smoothing
CB Predictor uses Holt�s double exponential smoothing instead 
of Brown�s double exponential smoothing. The difference is that 
when the single exponential smoothing equation is applied the 
second time, Holt�s method lets you use a different smoothing 
constant (β), compared to Brown�s method which uses the same 
constant for both operations. 

If the formula for single exponential smoothing is: 

S[1](t) = α * y(t) + (1 - α) * S[1](t - 1)

2
p 1�
------------
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Then the formula for Holt�s double exponential smoothing is:

S[2](t) = β * S[1](t) + (1 - β) * S[2](t - 1)

where S[2](t) represents the double exponential smoothing 
�smoothed estimate� for time period t, S[1](t) represents the 
single exponential smoothing �smoothed estimate� for time 
period t, y(t) is the historical data value at time t, and α and β are 
the smoothing constants with values between 0 and 1.

Seasonal forecasting method formulas
Below are the formulas for the seasonal time-series forecasting 
methods.

Seasonal additive smoothing
CB Predictor uses the following equations to calculate this 
method:

(Level) Lt = α * (Yt - St-s) + (1 - α) * Lt-1 

(Seasonal) St = γ * (Yt - Lt) + (1 - γ) * St-s 

(Forecast for period m) Ft+m = Lt + St+m-s

where the parameters are:

α alpha

γ gamma

m The number of periods ahead to forecast

s The length of the seasonality

Lt The level of the series at time t

St The seasonal component at time t
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Seasonal multiplicative smoothing

CB Predictor uses the following equations to calculate this 
method:

(Level) Lt = α * (Yt / St-s) + (1 - α) * Lt-1 

(Seasonal) St = γ * (Yt / Lt) + (1 - γ) * St-s 

(Forecast for period m) Ft+m = Lt * St+m-s

where the parameters are:

α alpha

γ gamma

m The number of periods ahead to forecast

s The length of the seasonality

Lt The level of the series at time t

St The seasonal component at time t

Holt-Winters� additive seasonal smoothing
(Level) Lt = α * (Yt - St-s) + (1 - α) * (Lt-1 + bt-1)

(Trend) bt = β * (Lt - Lt-1) + (1 - β) * bt-1

(Seasonal) St = γ * (Yt - Lt) + (1 - γ) * St-s 

(Forecast for period m) Ft+m = Lt + m*bt + St+m-s

where the parameters are:

α alpha

β beta

γ gamma

m The number of periods ahead to forecast

s The length of the seasonality

Lt The level of the series at time t

bt The trend of the series at time t

St The seasonal component at time t
CB Predictor User Manual 145



Appendix A Time-series Forecasting Method Formulas
Holt-Winters� multiplicative seasonal smoothing
(Level) Lt = α * (Yt / St-s) + (1 - α) * (Lt-1 + bt-1)

(Trend) bt = β * (Lt - Lt-1) + (1 - β) * bt-1

(Seasonal) St = γ * (Yt / Lt) + (1 - γ) * St-s 

(Forecast for period m) Ft+m = (Lt + m*bt) * St+m-s

where the parameters are:

α alpha

β beta

γ gamma

m The number of periods ahead to forecast

s The length of the seasonality

Lt The level of the series at time t

bt The trend of the series at time t

St The seasonal component at time t
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In this appendix

This appendix provides formulas for the 
three possible error measures that CB 
Predictor can use to determine the best 
time-series forecasting method:

� RMSE

� MAD

� MAPE

It also provides the formula for Theil�s U 
statistic.
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Time-series forecast error measures

CB Predictor calculates three different error measures for the fit 
of each time-series forecast. CB Predictor uses one of these error 
measures to determine which time-series forecasting method is 
the best.

RMSE
The formula for calculating RMSE is:

where Yt is the actual value of a point for a given time period t, 
n is the total number of fitted points, and  is the fitted forecast 
value for the time period t. For example, the RMSE for the 
sample data plotted in Figure 2.1 is 0.3068.

To calculate the RMSE for a set of data:

1. Measure the difference between each forecasted point ( ) 
and its corresponding actual point (Yt).

2. Square the difference.

3. Repeat steps 1 through 2 for each fitted point and sum the 
results. 

4. Divide the sum by the number of measured differences.

5. Take the square root.

RMSE

Yt Y� t�( )2

t 1=

n

∑

n
-------------------------------=

Y� t

Y� t
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MAD
The formula for calculating the MAD is:

where Yt is the actual value of a point for a given time period t, 
n is the total number of fitted points, and  is the forecast value 
for the time period t. For example, the MAD for the sample data 
plotted in Figure 2.1 is 0.2799.

To calculate the MAD for a set of data:

1. Measure the difference between each forecasted point ( ) 
and its corresponding actual point (Yt).

2. Take the absolute values of these differences.

3. Add up all the absolute values of the differences.

4. Divide the sum of the differences by the number of 
measured deviations (n).

MAPE
The formula for calculating the MAPE is:

where Yt is the actual value of a point for a given time period t, 
n is the total number of fitted points, and  is the forecast value 
for the time period t. 

CB Predictor Note:  If Yt equals zero, CB Predictor drops the term 
.

For example, the MAPE for the sample data plotted in Figure 
2.1 is 138.17%.

MAD

Yt Yt
��

t 1=

n

∑

n
---------------------------=

Y� t

Y� t

MAPE

Yt Y� t�( )
Yt

-------------------- 100( )
t 1=

n

∑

n
----------------------------------------------=

Y� t

Yt Y� t�( )
Yt

--------------------
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To calculate the MAPE for a set of data:

1. Measure the difference between each forecasted point ( ) 
and its corresponding actual point (Yt).

2. Divide the difference by the actual value.

3. Multiply the result of step 2 by 100.

4. Take the absolute value of this product.

5. Repeat steps 1 through 4 for each fitted point and sum the 
results. 

6. Divide the sum by the number of measured differences.

Time-series forecast statistics
There is one additional statistic calculated for any time-series 
forecast: Theil�s U statistic.

Theil�s U statistic
The formula for calculating Theil�s U statistic is:

where Yt is the actual value of a point for a given time period t, 
n is the number of data points, and  is the forecasted value.

To calculate the U statistic for a set of data:

1. Starting with the second time period, subtract the actual 

from the forecasted . 

2. Divide the result by the actual Y of the previous time period.

3. Square the result.

4. Repeat steps 1 to 3 for the rest of the data, except for the last 
one, and add the results.

Y� t

U

Y� t 1+ Yt 1+�
Yt

---------------------------- 
 

2

t 1=

n 1�

∑

Yt 1+ Yt�
Yt

---------------------- 
 

2

t 1=

n 1�

∑

---------------------------------------------=

Y� t

Y� t
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5. Starting with the second time period, subtract the actual Y 
of the previous time period from the forecasted Y of the 
current time period.

6. Divide the result by the actual Y of the previous time period.

7. Square the result.

8. Repeat steps 5 to 7 for the rest of the data, except for the last 
one, and add the results.

9. Divide the result of step 4 by the result of step 8.

10. Take the square root of the result in step 9.
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Techniques for 
Finding 
Regression 
Coefficients 



In this appendix

This appendix describes the two most 
common methods for finding the 
coefficients of a linear regression equation: 
least squares and singular value 
decomposition. 

It also describes why CB Predictor uses 
singular value decomposition instead of 
the least squares approach to determine 
the multiple linear regression equations.
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Finding regression coefficients

There are two common techniques used to find the coefficients 
of a regression equation that best fit the historical data:

� Least squares

� Singular value decomposition

Of these two techniques, CB Predictor uses singular value 
decomposition. The following sections describe both techniques 
and describe why CB Predictor uses the singular value 
decomposition technique.

Least squares
Least squares is a technique that estimates the coefficients of an 
equation that minimize the SSE. There are several ways to 
calculate the least squares coefficients, such as using partial 
differential equations or matrices. 

For the matrix technique, use the equation:

y = b0 + b1xt1 + b2xt2 + b3xt3 + ... + bpxtp + e

Which can be written in the form: 

y = X * b

where for n time periods and p independent variables, the 
matrices y and X are defined as:

y

y1

y2

.

.
yn

       and        X 

1 x11 x12 . . x1p

1 x21 x22 . . x2p

. . . . . .

. . . . . .
1 xn1 xn2 . . xnp

==
CB Predictor User Manual 155



Appendix C Techniques for Finding Regression Coefficients
Solving this equation using matrix algebra, gives the coefficients 
b as:

where X� is the transpose of the matrix X and (X�X)-1 is the 
inverse of the matrix X�X.

Singular value decomposition
Singular value decomposition is also technique for determining 
the coefficients of a regression equation. The primary difference 
between the singular value decomposition and the least squares 
techniques is that the singular value decomposition technique 
can handle situations where the equations used to determine the 
coefficients of the regression equation are singular or close to 
singular. This happens when performing regression on 
equations that represent parallel lines or surfaces.

In these cases, the least squares technique returns no solution 
for the singular case and extremely large parameters for the 
close-to-singular case.

CB Predictor uses the matrix technique for singular value 
decomposition. Starting with:

y = X * b

This can be rewritten as:

b

b0

b1

.

.
bp

X ′X( ) 1� X ′y= =

y U

w1 0 0 0
0 w2 0 0
0 0 … 0
0 0 0 wn

VT b•=
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Solving this, the regression coefficients are:

b V

1
wj
----- 0 0 0

0 1
wj
----- 0 0

0 0 1
wj
----- 0

0 0 0 1
wj
-----

UT y=
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In this appendix

This appendix provides formulas for the 
various regression statistics that CB 
Predictor calculates:

� R2

� Adjusted R2

� SSE

� F

� t

� P

� Durbin-Watson
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Regression statistics

The statistics used to analyze a regression are different from the 
statistics used to analyze a time-series forecast. The formulas for 
these regression statistics appear below.

R2

R2 is the coefficient of determination. This statistic represents 
the proportion of error that the regression accounts for. 

There are many methods to calculate R2. CB Predictor uses the 
equation:

Adjusted R2

You can calculate a regression equation by using the same 
number of data points as you have equation coefficients. 
However, the regression equation will not be as universal as a 
regression equation calculated using three times the number of 
data points as equation coefficients.

To correct the R2 for such situations, an adjusted R2 takes into 
account the degrees of freedom of an equation. When you 
suspect your R2 is higher than it should be, calculate the R2 and 
adjusted R2. If the R2 and the adjusted R2 for your equation are 
close, then your R2 is probably accurate. If R2 is much higher 
than the adjusted R2, then you probably don�t have enough data 
points to accurately calculate the regression.

The formula for adjusted R2 is:

where n is the number of data points you have and k is the 
number of independent variables.

R2 y�i y�( )2
∑
yi y�( )2

∑
--------------------------=

Glossary Term:
degrees of freedom�
The number of data points 
minus the number of 
estimated parameters 
(coefficients).

Adjusted R2 1 1 R2�( ) n 1�
n k� 1�
--------------------�=
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To calculate the adjusted R2 for a set of data:

1. Subtract one from the number of data points.

2. Calculate the number of data points minus the number of 
independent variables minus 1.

3. Divide the result from step 1 by the result from step 2.

4. Calculate R2 for the data. 

For more information, see �R2� on page 161.

5. Calculate 1 minus R2.

6. Multiply the result of step 5 by the result of step 3.

7. Calculate 1 minus the last result.

SSE
The formula for SSE is:

where n is the number of data points you have and e is the 
unexplained error (the deviation between the actual point and 
the forecasted point on the line) for each point.

To calculate the SSE for a set of data:

1. Measure the total deviation between each point and the line.

2. Square the deviations

3. Add together the squared deviations for each.

F
After finding a regression equation, the F statistic checks the 
significance of the relationship between the dependent variable 
and the particular combination of independent variables in the 
regression equation. The F statistic is based on the scale of the Y 
values, so analyze this statistic in combination with the P value 

SSE ei
2

i 1=

n

∑=
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(described in the next section). When comparing the F statistics 
for similar sets of data with the same scale, the higher F statistic 
is better.

The formula for the F statistic is:

where Yi is the actual value of a point for a given time period i, 
 is the mean of the data, n is the total number of fitted points, 

and  is the fitted forecast value for the time period i, m is the 
number of coefficients in the regression equation, and n is the 
number of data points.

To calculate the F statistic for a set of data:

1. Calculate the difference between each forecasted point ( ) 

and the mean( ).

2. Square the difference.

3. Repeat steps 1 through 2 for each fitted point and sum the 
results. 

4. Subtract 1 from the number of coefficients.

5. Divide the result of step 3 by the result of step 4.

6. Calculate the difference between each forecasted point and 
the actual point (Yi).

7. Square the difference.

8. Repeat steps 6 and 7 for each fitted point and sum the 
results.

9. Subtract the number of number of coefficients from the 
number of data points.

10. Divide the result of step 8 by the result of step 9.

11. Divide the result of step 5 by the result of step 10.

F
Y� i Y�( )2 m 1�( )⁄∑
Yi Y� i�( )2 n m�( )⁄∑

---------------------------------------------------=

Y
Yi
�

Y� t
Y
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t
If your F statistic and P indicate a significant relationship 
between the dependent and the independent variables as a 
whole, you then want to see the significance of the relationship 
of the dependent variable to each independent variable. The t 
statistic tests for the significance of the specified independent 
variable in the presence of the other independent variables.

The formula for the t statistic is:

where bp is the coefficient to check and se(bp) is the standard 
error of the coefficient. To calculate the standard error of the 
coefficient, CB Predictor uses the matrix technique. Start with 
the regression equation:

y = b0 + b1xt1 + b2xt2 + b3xt3 + ... + bpxtp + e

where t is the time period and p is the index of the independent 
variable. Define the matrix:

The standard error of the coefficient is:

where cpp is a diagonal element of the matrix (X�X)-1 and the 
standard error, s, for yt is:

t
bp

se bp( )
---------------=

X 

1 x11 x12 . . x1p

1 x21 x22 . . x2p

. . . . . .

. . . . . .
1 xn1 xn2 . . xnp

=

sbp s cpp=

s

yt y�t�( )2

n 1=

p

∑

n p 1+( )�
-------------------------------=
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P

CB Predictor calculates P and displays it with the other statistics. 
However, you can look up P for any F statistic using a table of 
critical F statistic values, available in most forecasting books. 
When using a critical F statistic table, you need to know the F 
statistic and the explained and unexplained degrees of freedom 
(m - 1 and n - m, respectively).

Durbin-Watson
The formula for calculating the Durbin-Watson statistic is:

where et is the difference between the estimated point ( )and 
the actual point (Yi) and n is the number of data points.

To calculate the Durbin-Watson statistic for a set of data:

1. For each point, calculate the error by subtracting the 

estimated point ( ) from the actual point (Yi).

2. Starting with the second data point, subtract from the error 
the error of the previous data point.

3. Square the difference.

4. Repeat steps 2 and 3 for the rest of the data points.

5. Add the squares.

6. Starting with the first data point, square each error.

7. Add up the squares.

8. Divide the result of step 5 by the result of step 7.

DW

et et 1��( )2

t 2=

n

∑

et
2

t 1=

n

∑

------------------------------------=

Y� i

Y� i
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Appendix E

Error Recovery



In this appendix

This appendix lists, alphabetically by first 
word, messages that may be displayed when 
you are entering or selecting data, or 
running simulations. Either an explanation 
or a solution or both are provided for each 
message. Messages not listed in this 
appendix should be self-explanatory.
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Error messages

There are several problems that you might find while running 
CB Predictor. Below is a list of all the error messages, in 
alphabetical order, the reason the error message appeared, and 
the steps to try to resolve the problem. 

Message Reason Solution

Bad value for seasonality. You entered an invalid 
value for the number of 
periods for each season.

In the Data tab, make sure 
that the seasonality is an 
integer between 1 and 
either 100 or half the 
number of historical data 
points for the series, 
whichever is smaller.

Cannot find any data in 
range.

You selected only blank 
cells or your selected range 
only includes data in the 
first row or column that you 
indicated was your date row 
or column.

Reselect your data.

Or, on the Data tab, 
uncheck the option to treat 
the first row or column as 
the dates.

Cannot find any data to 
forecast in the specified 
range. Reselect your data 
or uncheck the [Treat First 
Row/Column As Date] 
option.

Your selected range either 
doesn�t include data.

Reselect your data.

Cannot perform MLR until 
you identify your regres-
sion variables (no indepen-
dent or dependent 
variables).

To use regression, you must 
identify at least one depen-
dent variables and one 
independent variable.

Open the Regression 
Variables dialog and select 
at least one dependent and 
one independent variable.

Could not allocate memory 
for calculating the Single 
Exponential Smoothing 
starting points. Reduce the 
number of historical data 
series.

You have run into a pro-
gram limitation that will 
keep you from forecasting 
all your historical series at 
once. 

Select fewer data series to 
forecast at a time.
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Could not allocate memory 
for calculating the Additive 
Seasonal No Trend 
method. Reduce the num-
ber of historical data series.

You have run into a pro-
gram limitation that will 
keep you from forecasting 
all your historical series at 
once. 

Select fewer data series to 
forecast at a time.

Could not allocate memory 
for calculating the Double 
Exponential Smoothing 
method. Reduce the num-
ber of historical data series.

You have run into a pro-
gram limitation that will 
keep you from forecasting 
all your historical series at 
once. 

Select fewer data series to 
forecast at a time.

Could not allocate memory 
for calculating the Double 
Moving Average method. 
Reduce the number of his-
torical data series.

You have run into a pro-
gram limitation that will 
keep you from forecasting 
all your historical series at 
once. 

Select fewer data series to 
forecast at a time.

Could not allocate memory 
for calculating the Holt-
Winters' Additive method. 
Reduce the number of his-
torical data series.

You have run into a pro-
gram limitation that will 
keep you from forecasting 
all your historical series at 
once. 

Select fewer data series to 
forecast at a time.

Could not allocate memory 
for calculating the Holt-
Winters' Multiplicative 
method. Reduce the num-
ber of historical data series.

You have run into a pro-
gram limitation that will 
keep you from forecasting 
all your historical series at 
once. 

Select fewer data series to 
forecast at a time.

Could not allocate memory 
for calculating the Multipli-
cative Seasonal No Trend 
method. Reduce the num-
ber of historical data series.

You have run into a pro-
gram limitation that will 
keep you from forecasting 
all your historical series at 
once. 

Select fewer data series to 
forecast at a time.

Could not allocate memory 
for calculating the Single 
Exponential Smoothing 
method. Reduce the num-
ber of historical data series.

You have run into a pro-
gram limitation that will 
keep you from forecasting 
all your historical series at 
once. 

Select fewer data series to 
forecast at a time.

Message Reason Solution
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Could not allocate memory 
for calculating the Single 
Moving Average method. 
Reduce the number of his-
torical data series.

You have run into a pro-
gram limitation that will 
keep you from forecasting 
all your historical series at 
once. 

Select fewer data series to 
forecast at a time.

Error establishing a con-
nection with Excel. Close 
and restart your forecasting 
application.

Some problem corrupted 
the communication 
between CB Predictor and 
Excel.

Close the CB Predictor 
wizard and restart it.

Or, close Excel and restart 
both Excel and CB 
Predictor.

Or close Windows and 
restart Windows, Excel, and 
CB Predictor.

Error in data range. There is some error in your 
selected data. 

Check your selected data 
range and eliminate 
unusual characters, values, 
or formula cells.

Invalid value for lag. You entered an invalid 
string in the Lag field. The 
lag must be a positive inte-
ger.

Enter a positive integer in 
the Lag field.

Lag is too large or too 
small for the amount of 
data selected.

The value in the Lag field 
is invalid for your data. The 
lag must be an integer 
greater than zero and less 
than one third the number 
of data points in the series.

Make sure the number in 
the Lag field is an integer 
greater than zero and less 
than one third the number 
of data points in the series.

Lead or holdout must be 
greater than 0 and less than 
25% of the number of data 
points.

You entered an invalid 
number in the Simple 
Lead, Weighted Lead, or 
Holdout field.

Make sure you enter an 
integer greater than 0 and 
less than 25% of the 
number of data points in 
the Simple Lead, Weighted 
Lead, or Holdout field.

No active methods. Please 
select methods from the 
Method Gallery.

You don�t have any meth-
ods selected from the 
Method Gallery.

In the Method Gallery, 
select at least one method 
to use to forecast your data.

Message Reason Solution
CB Predictor User Manual 171



Appendix E Error Recovery
One test must be chosen. 
Choose either R-squared or 
F-test or both.

You must select at least one 
stopping criteria for step-
wise regression.

Select either the R-squared 
or F-test stopping criteria.

Probability to remove must 
be at least 0.05 greater than 
the probability to add.

The value in the Probability 
To Remove field must be at 
least 0.05 greater than the 
value in the Probability To 
Add field.

Make sure the value in the 
Probability To Remove field 
is at least 0.05 more than 
the value in the Probability 
To Add field. 

Selected value used to 
determine best fit is not 
MAD, MAPE, or RMSE. 
Select one of these.

This indicates that there is 
a problem with fit selection 
method.

In the Method Gallery tab, 
click on the Fit button and 
make sure that one of the 
error fitting techniques in 
the dialog is selected.

If it still doesn�t work, call 
Decisioneering technical 
support.

Some values in the data 
range are too high or too 
low.

You cannot use values 
above 1 x 1020 or below 1 x 
10-20.

Remove values above 
1 x 1020 or below 1 x 10-20. 
If these values are necessary 
for your calculations, try 
scaling your data.

The forecasting program 
had a problem finding the 
best parameters for Dou-
ble Exponential Smooth-
ing. Set the parameters 
manually.

Your historical data had 
some unusual pattern that 
kept CB Predictor from 
automatically calculating 
the optimal parameters for 
Double Exponential 
Smoothing.

Check your data and 
eliminate outliers. 

Or, try manually setting the 
Double Exponential 
Smoothing parameters.

Or, uncheck Double 
Exponential Smoothing in 
the Method Gallery tab.

Message Reason Solution
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The forecasting program 
had a problem finding the 
best parameters for Single 
Exponential Smoothing. 
Set the parameters manu-
ally.

Your historical data had 
some unusual pattern that 
kept CB Predictor from 
automatically calculating 
the optimal parameters for 
Single Exponential 
Smoothing.

Check your data and 
eliminate outliers. 

Or, try manually setting the 
Single Exponential 
Smoothing parameters.

Or uncheck Single 
Exponential Smoothing in 
the Method Gallery tab.

The forecasting program 
had a problem finding the 
best parameters for the 
Additive Seasonal No 
Trend method. Set the 
parameters manually.

Your historical data had 
some unusual pattern that 
kept CB Predictor from 
automatically calculating 
the optimal parameters for 
Additive Seasonal No 
Trend.

Check your data and 
eliminate outliers. 

Or, try manually setting the 
Additive Seasonal No Trend 
parameters.

Or uncheck Additive 
Seasonal No Trend in the 
Method Gallery tab.

The forecasting program 
had a problem finding the 
best parameters for the 
Multiplicative Seasonal No 
Trend method. Set the 
parameters manually.

Your historical data had 
some unusual pattern that 
kept CB Predictor from 
automatically calculating 
the optimal parameters for 
Multiplicative Seasonal No 
Trend.

Check your data and 
eliminate outliers. 

If that doesn�t help, try 
manually setting the 
Multiplicative Seasonal No 
Trend parameters.

Or uncheck Multiplicative 
Seasonal No Trend in the 
Method Gallery tab.

The method parameter 
must be between 0.001 and 
0.999.

You entered an invalid 
value for one of the method 
parameters.

Make sure all the method 
parameter fields (alpha, 
beta, or gamma) have 
values between 0.001 and 
0.999.
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The minimum number of 
data points for any forecast 
method is 5.

You must have at least 5 
historical data points to use 
time-series forecasting.

Or the number of points 
after excluding the holdout 
points is less than 5.

Make sure you have at least 
5 historical data points.

If you have more than 5 
data points, check the 
Forecasting Technique in 
the Advanced Options 
dialog. If you are using 
Holdout, lower the number 
of holdout points or use a 
different technique.

The number of periods to 
forecast must be an integer 
between 1 and 100.

You entered an invalid 
number for the number of 
periods to forecast. Your 
number might be negative, 
a decimal number, or less 
than one.

On the Results tab, change 
the number of forecasted 
data points to an integer of 
at least 1.

The paste range value 
entered is not valid.

In Step 9, the Paste Fore-
casts At Cell field requires a 
cell or range of cells.

Enter a cell (such as F6) or 
range of cells (such as 
H1:H5).

The size must be an integer 
between 20% and 400%.

When specifying the size of 
a chart, you must use an 
integer between 20 and 400 
to represent the percent-
age.

In the Preferences dialogs, 
make sure the Chart Size 
field has an integer between 
20 and 400.

There is at least one non-
numeric cell in the data 
range.

Your data, not including 
headers and dates, has at 
least one cell with illegal 
characters in it.

If you have headers and 
dates, make sure that the 
header and date options on 
the Data tab are checked.

Or, check your historical 
data, not including headers 
and dates, for cells with 
formulas or characters 
instead of numbers.

Unrecognized error. You encountered an undoc-
umented error.

Call Decisioneering 
technical support and 
describe how you found the 
error.

Message Reason Solution
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Value must be between zero 
and one.

The Threshold and all the 
Probability values must be 
between 0.001 and 0.999.

Make sure the Threshold, 
Probability, Probability To 
Add, and Probability To 
Remove fields all have 
values between 0.001 and 
0.999.

You cannot use Double 
Moving Average to forecast 
more than 33% of the origi-
nal number of historical 
data points. Lower the Peri-
ods parameter (by double-
clicking the DMA icon in 
the Method Gallery) to less 
than 33% of the number of 
historical data points.

You are trying to forecast 
more data points than is 
reasonable for the Double 
Moving Average method 
with your number of histor-
ical data points.

In the DMA Parameters 
dialog, lower the Periods 
parameter to less than 33% 
of the number of historical 
data points.

Or, use more historical 
data.

Or, on the Method Gallery 
tab, unselect Double 
Moving Average.

You cannot use Single Mov-
ing Average to forecast 
more than 50% of the origi-
nal number of historical 
data points. Lower the Peri-
ods parameter (by double-
clicking the SMA icon in 
the Method Gallery) to less 
than 50% of the number of 
historical data points.

You are trying to forecast 
more data points than is 
reasonable for the Single 
Moving Average method 
with your number of histor-
ical data points.

In the SMA Parameters 
dialog, lower the Periods 
parameter to less than 50% 
of the number of historical 
data points.

Or, use more historical 
data.

Or, on the Method Gallery 
tab, unselect Single Moving 
Average.

You must use at least 6 his-
torical data periods to use 
Double Moving Average. 
Use more historical data or 
unselect Double Moving 
Average in the Method Gal-
lery.

Double Moving Average 
requires at least 6 historical 
data points.

Use at least 6 historical data 
points.

Or, uncheck Double 
Moving Average in the 
Method Gallery tab.
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In this glossary

A compilation of terms specific to CB 
Predictor as well as statistical terms used in 
this manual.



Glossary

Adjusted R2

Corrects R2 to account for the degrees of freedom in the data. 

assumptions
Estimated values in a spreadsheet model that Crystal Ball 
defines with a probability distribution.

autocorrelation
Describes a relationship or correlation between values of the 
same data series at different time periods.

autoregression
Describes a relationship similar to autocorrelation, except 
instead of the variable being related to other independent 
variables, it is related to previous values of its own data series.

causal methods
A relationship between two variables where changes in one 
independent variable not only correspond to a particular 
increase or decrease in the dependent variable, but actually 
cause the increase or decrease.

Crystal Ball
Decisioneering�s risk analysis add-in for Excel.

Crystal Ball forecast
A statistical summary of the assumptions in a spreadsheet 
model, output graphically or numerically.

degrees of freedom
The number of data points minus the number of estimated 
parameters (coefficients).

dependent variable
In multiple linear regression, a data series or variable that 
depends on another data series. You should use multiple linear 
regression as the forecasting method for any dependent 
variable.

DES
Double exponential smoothing. 
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double exponential smoothing
Double exponential smoothing applies single exponential 
smoothing twice�once to the original data and then to the 
resulting single exponential smoothing data. It is useful where 
the historic data series is not stationary.

double moving average
Smooths out past data by performing a moving average on a 
subset of data that represents a moving average of an original 
set of data.

Durbin-Watson
Tests for autocorrelation of one time lag. 

error
The difference between the actual data values and the forecasted 
data values. 

forecast
The prediction of values of a variables based on known past 
values of that variable or other related variables. Forecasts can 
also describe predicted values based on Crystal Ball spreadsheet 
models and expert judgements.

forward stepwise
A regression method that adds one independent variable at a 
time to the multiple linear regression equation, starting with the 
independent variable with the greatest significance. 

F-test statistic
See F statistic.

F statistic
Tests the overall significance of the multiple linear regression 
equation. 

holdout
Optimizes the forecasting parameters to minimize the error 
measure between a set of excluded data and the forecasting 
values. CB Predictor does not use the excluded data to calculate 
the forecasting parameters.
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Holt-Winters� additive seasonal smoothing
Separates a series into its component parts: seasonality, trend 
and cycle, and error. This method determines the value of each, 
projects them forward and reassembles them to create a forecast.

Holt�s double exponential smoothing
Similar to double exponential smoothing, but this method lets 
you use a different smoothing constant for the second 
smoothing process.

Holt-Winters� multiplicative seasonal smoothing
Considers the effects of seasonality to be multiplicative, that is, 
growing (or decreasing) over time. This method is similar to the 
Holt-Winters� additive method.

HyperCasting
CB Predictor�s ability to create a regression equation, forecast 
independent variables, and combine the forecasts and equation 
to forecast a dependent variable in one step.

hyperplane
A geometric plane that spans more than two dimensions.

independent variable
In multiple linear regression, the data series or variables that 
influence the another data series or variable.

Intelligent Input
CB Predictor�s ability to select all the adjacent data, headers, 
and dates to define the selection to forecast. The Intelligent 
Input also determines whether the data is in rows or columns 
and whether there are dates or headers. To use the Intelligent 
Input, select one cell in your data range before starting the CB 
Predictor wizard.

iterative stepwise regression
A regression method that adds or subtracts one independent 
variable at a time to or from the multiple linear regression 
equation.
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lag
Defines the offset when comparing a data series with itself. For 
autocorrelation, this refers to the offset of data that you choose 
when correlating a data series with itself. 

lead
A type of forecasting that optimizes the forecasting parameters 
to minimize the error measure between the historical data and 
the fit values, offset by a specified number of periods (lead). 

least-squares approach
Measures how closely a line matches a set of data. This measures 
the distance of each actual data point from the line, squares each 
distance, and adds up the squares. The line with the smallest 
square deviation is the closest fit.

level
A starting point for the forecast. For a set of data with no trend, 
this is equivalent to the y-intercept.

linear equation
An equation with only linear terms. A linear equation has no 
terms containing variables with exponents or variables 
multiplied by each other.

linear regression
A process that models a variable as a function of other first-
order explanatory variables. In other words, it approximates the 
curve with a line, not a curve, which would require higher-order 
terms involving squares and cubes.

MAD
Mean absolute deviation. This is an error statistic that average 
distance between each pair of actual and fitted data points.

MAPE
Mean absolute percentage error. This is a relative error measure 
that uses absolute values to keep the positive and negative errors 
from cancelling each other out and uses relative errors to let you 
compare forecast accuracy between time-series models.
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multiple linear regression
A case of linear regression where one dependent variable is 
described as a linear function of more than one independent 
variable.

näive forecast
A forecast obtained with minimal effort based only on the most 
recent data. E.g., Using the last data point to forecast the next 
period.

P 
Indicates the probability of obtaining an F or t statistic as large 
as the one calculated for your data. 

partial F statistic
Tests the significance of a particular independent variable 
within the existing multiple linear regression equation. 

PivotTable
An interactive table in Excel. You can move rows and columns, 
and filter PivotTable data.

regression
A process that models a dependent variable as a function of 
other explanatory (independent) variables.

residuals
The difference between the actual data and the predicted data 
for the dependent variable in multiple linear regression.

RMSE
Root mean squared error. This is an absolute error measure that 
squares the deviations to keep the positive and negative 
deviations from cancelling each other out. This measure also 
tends to exaggerate large errors, which can help when 
comparing methods.

R2

Coefficient of determination. This statistic indicates what 
proportion of the dependent variable error that the regression 
line explains.
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seasonality
The change that seasonal factors cause in a data series. For 
example, if sales increase during the Christmas season and 
during the summer, the data is seasonal with a one-year period.

SES
Single exponential smoothing.

single exponential smoothing
Weights past data with exponentially decreasing weights going 
into the past; that is, the more recent the data value, the greater 
its weight. This largely overcomes the limitations of moving 
averages or percentage change models. 

single moving average
Smooths out past data by averaging the last several periods and 
projecting that view forward. CB Predictor automatically 
calculates the optimal number of periods to be averaged.

singular value decomposition
A method that solves a set of equations for the coefficients of a 
regression equation.

smoothing
Estimates a smooth trend by removing extreme data and 
reducing data randomness.

SSE
Sum of square deviations. The least squares technique for 
estimating regression coefficients uses this statistic, which 
measures the error not eliminated by the regression line.

SVD
Singular value decomposition.

time series
A set of values that are ordered in equally spaced intervals of 
time.

trend
A long-term increase or decrease in time-series data.
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t statistic
Tests the significance of the relationship between the dependent 
variable and any individual independent variable, in the 
presence of the other independent variables.

variables
In regression, data series are also called variables.

weighted lead
A type of forecasting that optimizes the forecasting parameters 
to minimize the average error measure between the historical 
data and the fit values, offset by several different periods (leads). 
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In this index

A comprehensive index designed to 
give you quick access to the 
information in this manual.



Index

A
additive methods

Holt-Winters� seasonal smoothing 46
seasonal smoothing 45

adjusted R squared
description 57
formula 161

Advanced button 92
Advanced Options dialog 95
All Series list 84
alpha

for nonseasonal methods 44
for seasonal smoothing methods 47

assumptions
description 133
generating 136

asterisk in Method Gallery 89
autocorrelation in regression 58
Autocorrelation view 76
automatic loading CB Predictor 67
Automatic option, for parameters 93

B
bakery example 121
best methods, determining error measures 89
beta

for Holt�s double moving average 44
for seasonal smoothing methods 47

C
captures, screen 12
CB Predictor

10-step process 68
Intelligent Input 70
loading automatically 67
loading manually 68
loading with Crystal Ball 133
starting 66
with Crystal Ball 133

cells, handling empty 70
charts 114

customizing 118
preferences 106

Clear All button 92
Index 193



4 Index

coefficients

finding regression 53, 155
of determination 57
testing coefficients 58

company web site 11
confidence interval, setting 97
consulting service 11
conventions, manual 11
creating spreadsheets 65
criteria, setting stopping 85
criteria, stopping stepwise 55
Crystal Ball 39, 133

assumptions 133
example 137
forecasts 133
loading with CB Predictor 133

customizing reports and charts 118

D
data

arrangement 71
historical statistics 59
minimum historical 69
selecting historical 69
viewing historical 72
with empty cells 70

Data Attributes tab 81
step 4 78
step 5 79

Data In Rows/Columns option 74
dates

formatting 65
including 74

decomposition, singular value 53
dependent variables 79
DES, see Holt�s double exponential smoothing
deviation, standard 59
dialogs

Stepwise Options 85
View Historical Data 75

DMA, see double moving average
Do Not Forecast option 84
double exponential smoothing, see Holt�s double exponential

smoothing
double moving average 41
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Durbin-Watson

description 58
formula 165

E
equations

adjusted R squared 161
Durbin-Watson 165
F statistic 162
Holt�s double exponential smoothing 143
Holt-Winters� additive seasonal smoothing 145
Holt-Winters� multiplicative seasonal smoothing 146
least squares 155
linear regression 53
MAD 150
MAPE 150
nonseasonal methods 143
R squared 161
regression statistics 161
RMSE 149
seasonal additive 144
seasonal methods 144
seasonal multiplicative 145
single exponential smoothing 143
singular value decomposition 156
SSE 162
t statistic 164
Theil�s U 151

error measures
MAD 49
MAD formula 150
MAPE 49
MAPE formula 150
RMSE 49
RMSE formula 149
selecting 89

errors
messages 169
time-series measures 48

example file names 12
Index 195



4 Index

examples

financial 125
human resources 127
inventory control 121
Monica�s bakery 121
shampoo sales 16
Toledo gas 25
using Crystal Ball 137

F
F statistic

as stopping criteria
description 57
formula 162

financial example 125
First Column (Row) Has Headers 74
First Row (Column) Has Dates 74
forecasting

categories of 39
holdout 51
maximum number of series 65
references 179
simple lead 50
techniques 49
time-series 15, 40
weighted lead 51

forecasting methods
nonseasonal formulas 143
seasonal formulas 144

forecasting statistics
Theil�s U 52

forecasting techniques
holdout 51
simple lead 50
standard 50
weighted lead 51

forecasts
Crystal Ball 133
previewing and running 110
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formulas

adjusted R squared 161
Durbin-Watson 165
F statistic 162
Holt�s double exponential smoothing 143
Holt-Winters� additive seasonal smoothing 145
Holt-Winters� multiplicative seasonal smoothing 146
least squares 155
MAD 150
MAPE 150
nonseasonal methods 143
R squared 161
regression statistics 161
RMSE 149
seasonal additive smoothing 144
seasonal methods 144
seasonal multiplicative smoothing 145
single exponential smoothing 143
singular value decomposition 156
SSE 162
t statistic 164
Theil�s U 151
time-series methods 143

forward stepwise regression 54
F-test, see F statistic

G
gamma, for seasonal smoothing methods 47
gas tutorial 25

H-K
hardware requirements 8
headers 74
historical data

arrangement 71
minimum required 69
selecting 69
statistics 59
viewing 72

holdout forecasting 51
Holt�s double exponential smoothing

description 43
formulas 143
Index 197



4 Index

Holt-Winters� additive seasonal smoothing

description 46
formulas 145

Holt-Winters� multiplicative seasonal smoothing
description 47
formulas 146

how the program works 24
how this manual is organized 8
human resources example 127
HyperCasting 79
hyperplanes 53
identifying time periods and seasonality 78
independent variables

defining 79
setting lag 84

Input Data tab 73
step 1 69
step 2 71
step 3 72

Input, Intelligent 70
Intelligent Input 70
intervals, confidence 97
inventory example 121
iterative stepwise regression 55

L
lag option 84
lead forecasting

simple 50
weighted 51

least squares 155
linear regression

description 53
steps 27, 79

linear smoothing 41
Ljung-Box statistic 61
loading

CB Predictor automatically 67
CB Predictor manually 68
with Crystal Ball 133
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M
MAD

description 49
formula 150

manual
conventions 11
organization 8

manual loading 68
MAPE

description 49
formula 150

maximum 60
maximum number of forecasts 65
mean 59
mean absolute deviation, see MAD
mean absolute percentage error, see MAPE
measures

selecting error 89
time-series error 48

measures, error
MAD 49
MAPE 49
RMSE 49

messages, error 169
Method Gallery 91
methods

nonseasonal formulas 143
regression 54
seasonal 88
seasonal additive 45
seasonal formulas 144
seasonal multiplicative 45
seasonal smoothing 44
selecting time-series 87
setting regression 82
standard regression 54

methods tables
description 116
preferences 109

minimum 60
minimum historical data 69
moving averages

double 41
periods 44
single 41
Index 199
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multiple linear regression

description 53
steps 27, 79

multiplicative methods
Holt-Winters� seasonal smoothing 47
seasonal smoothing 45

N
Number Of Periods To Forecast field 100

O
options

Do Not Forecast 84
lag 84

Override Best button 112

P
parameters

automatic 93
dialogs 93
nonseasonal methods 44
seasonal smoothing 47
user-defined 93

pasted forecasts 113
preferences 103
values as assumptions 136

periods
moving average parameter 44
number to forecast 97

PivotTables
methods 116
results 116

Preferences
button 101
dialog 102

preferences
charts 106
methods table 109
paste 103
reports 104
results table 108

Preview
button 75
dialog 111

previewing forecasts 110
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probability 58

R
R squared

as stopping criteria 55
description 57
formula 161

R squared, adjusted 57
Range field 73
ranges with empty cells 70
Raw Data view 75
references 179
referral service 11
regression 53

adjusted R squared 57
detecting autocorrelation 58
determining coefficients 53
Durbin-Watson 58
equation 53
F statistic 57
finding coefficients 155
forward stepwise 54
methods 54
P 58
pasted assumptions 136
R squared 57
SSE 57
statistics 56
steps 27, 79
t statistic 58
testing equation 57
testing probability 58
using 79

regression methods
iterative stepwise 55
standard 54

regression methods, setting 82
Regression Variables dialog 83
reports 115

customizing 118
preferences 104

requirements, system 8
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results

charts 114
methods table 116
pasted forecasts 113
reports 115
results table 116
selecting 98
title 101

Results tab 99
step 10 110
step 7 97
step 8 97
step 9 98

results tables
description 116
preferences 108

RMSE
description 49
formula 149

root mean squared error, see RMSE
Run button 75
running forecasts 110

S
screen captures 12
seasonal additive smoothing

description 45
formulas 144

seasonal methods 88
Holt-Winters� additive seasonal smoothing 46
Holt-Winters� multiplicative seasonal smoothing 47
seasonal additive smoothing 45
seasonal multiplicative smoothing 45

seasonal multiplicative smoothing
description 45
formulas 145

seasonal smoothing
methods 44
parameters 47

seasonality, identifying 78
Select All button 92
Select button

on Input Data tab 73
on Results tab 100

Select Variables button 82
202 CB Predictor User Manual



Index

selecting

historical data 69
methods 87
results 98

services
consulting referral 11
technical support 11

SES, see single exponential smoothing
setting method parameters 93
setting stopping criteria 85
shampoo tutorial 16
simple lead forecasting 50
single exponential smoothing

description 42
formula 143

single moving average 41
singular value decomposition

formulas 156
use 53

SMA, see single moving average
smoothing

linear 41
seasonal 44

smoothing methods
Holt�s double exponential 43
Holt-Winters� additive seasonal 46
Holt-Winters� multiplicative seasonal 47
seasonal 44
seasonal additive 45
seasonal multiplicative 45
single exponential 42

software requirements 8
spreadsheets

creating 65
titles 65

SSE
description 57
formula 162

standard
forecasting technique 50
regression 54

standard deviation 59
starting CB Predictor 66
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statistics

adjusted R squared 57
Durbin-Watson 58
Durbin-Watson formula 165
F 57
historical data 59
Ljung-Box 61
maximum 60
mean 59
minimum 60
P 58
R squared 57
R squared formula 161
regression 56
regression formulas 161
SSE 57
SSE formula 162
standard deviation 59
t 58
t formula 164
Theil�s U 52
Theil�s U formula 151
viewing for historical data 74

steps
1 69
10 110
2 71
3 72
4 78
5 79
6 87
7 97
8 97
9 98
process of 10 68

Stepwise Options dialog 85
stepwise regression

forward 54
iterative 55
stopping criteria 55

stopping criteria 55
setting 85

sum of square deviations 57
support, technical 11
system requirements 8
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T
t statistic

description 58
formula 164

tables
methods 116
results 116

technical support 11
techniques

forecasting 49
templates, report and chart 118
Theil�s U

description 52
formula 151

time periods
identifying 78
number to forecast 97

time-series
error measures 48
forecasting overview 15

time-series forecasting, see forecasting
time-series methods

pasted assumptions 136
selecting 87
specialties 87

titles
results 101
spreadsheet 65

Toledo Gas tutorial 25
tutorials

shampoo sales 16
Toledo gas 25

U
user-defined parameters 93

V
variables

dependent and independent 79
regression 79
setting independent lag 84

View Data button 74
View Historical Data dialog 75
viewing historical data 72
Index 205
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W
web site 11
weighted lead forecasting 51
what you need 8
who this program is for 7
worksheets, creating 65

Z
zeros in data 70
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